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WHEDNE.

Welcome to my exclusive course, The Digital Way! Photoshop is
one of the best and most powerful photo manipulation courses to
date. Most, if not all, graphic designers use it in the workplace to
fulfill client’s needs. This course prepares students for the
workplace, and more importantly, the Adobe Certified Associate
Exam. | just recently took the exam for Photoshop. The exam is
going to take time to train and prep for, and | hope that this
course can do that for you.

- Zac DelLane, Author of the Digital Way

dUUTY READ TS 3004

All files, worksheets, and activities can be accessed online via
The Digital Way website. Go to https://goo.gl/gsjG18, and select
the module you’re in.

If you want feedback on assignments and receive correct
answers, try my Google Classroom! | can give critical feedback
on designs, work, and lots more. As of this book publishing, you

can go to classroom.google.com and put in code “fo7ykze”.

Each lesson follows a similar structure:

e Lecture
e Activity A/B/C
e Quiz

At the end of each module, there is a Test Prep, and a Written
and Visual test.
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Wl AR e e Eal] LEALGY

This book covers the concepts of Photography Manipulation and
Design. | designed this book with the Adobe Certified Associate
exam, lining up the chapters to match the main domains and
learning points, while keeping it in a sequential order that makes
sense. Once you get to Chapter/Module #6, tggEdu goals will be
covered for the tggEdu Photography Mastery Certification.
Module #1-5 are all about prep for the Adobe Certified Associate
exams. Will all areas of the exam be covered in this book? No,
but I created this book from memory of questions | remember
getting wrong, so you don’t get them wrong too.
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LUREDBE

All images have a purpose, e Purpose Identify the purpose,
whether emotional, e Audience audience, and audience
historical, or personal. e Demographics needs for preparing
images.

Every image has a purpose. This purpose can vary from image to
image.

For instance, say you look at an image of your dog. What do you
feel? All images have a connection to our emotions, thoughts,
and sometimes your history.

As a designer, you need to be able to find images for your client
that are useful and fit the purpose of the business. Look at these
images.

You may find scenarios where you would use each of these
images. As well, you may have ties (like emotional, thoughts
that come to mind, or your prior experiences) to each of these
images.
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Remember that every single image has a purpose. Every person
that sees an image thinks of something. As the designer, you
need to be able to recognize the purpose behind the image to
designate what is appropriate for your project.

Understanding your target audience and the demographics your
appealing to can make or break your project. Ask your client key
questions, like

« What target audience are you appealing to? (seniors,
young kids, gender, etc.)
o These groupings are called Demographics.

« What is the purpose of your business/company?

e« What reaction do you want from your audience?

Remember, the images you choose to use in your project convey
messages to audiences. You need to choose images, colors, and
elements in your design that appeal to your target audience.

Lesson #1-1 Quick Check

Define the following terms: Expand your Thinking:
Purpose Demographics Audience
Answer the following questions:
. . Create a Venn
- Why is it important to appeal to your audience? diagram, comparing
- How can you measure demographics? 2 differe’nt images
and the emotion
tied to them.
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#1-1 Activity A

For each box, find an image on Google that would match all the
requirements, and paste into the box.

Description Image

You are designing a poster for a after school kids
club. You want to include a picture that makes not
just kids, but parents to take their kids to the
after-school club.

You are creating a web graphic that is to promote
a new video game coming out. You want to
include a photo that appeals for kids to buy this
new product.

You are creating a print advertisement to
advertise a new school club, all about chess.

You're creating an infographic that details global
warming in the arctic regions.
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Lesson  #1-1  Activity B

Fill out each box with the correct definition of each term.
Remember, these terms will come back on quizzes and future
tests.

Demographics

Audience

Audience Purpose

Audience Reaction

Target Audience

Answer the following questions:

When should you meet with your client to discuss your target
audience/demographics?

What else should you and your client discuss before starting the
project?
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Images and designs are e Copyright Summarize how designers
protected by a legal right e Licensing make decisions about the
known as copyright. e Fair Use type of content to include

in a project, including

considerations such as

copyright, project fit,
permissions, and licensing.

Copyright and design is one of the MOST IMPORTANT factors
that goes into designs! This can affect your entire design,
mainly, the images you use within your design.

the exclusive legal right, given to an
originator or an assignee to print, publish,
perform, film, or record literary, artistic,
or musical material, and to authorize
others to do the same.

From google.com

Figure 2.1 — Defines Copyright

Remember, copyright is the legal right given to creators that
protects their work under the strict law. Copyright works last for
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the creator’s lifetime, plus 70 years after they die. If you are
unsure about using a certain image, don’t use it, or contact
the owner of the image.

Licensing is the process done to gain rights to use an image for
professional use. This can be done by websites, such as
suttershock.com, or done by the owner directly. Generally,
licensing does cost money.

REMEMBER:

YOU MUST contact the owner of the image, or license through a 3rd party.

Just giving credit to the image or in the Metadata IS NOT ACCEPTABLE and
could lead to legal actions.

Fair Use is the principle of using copyrighted materials with See an example of
specific reasons. The overall reasons/justifications for fair use ;‘nggwa't‘z“r’]"t'r]r‘e
are Criticism, Comment, News Reporting, Teaching, Scholarship, video at

and Research. https://goo.gl/WnqLe5

Some resources to keep in mind to prevent copyright are using
Google Images advance search, and Creative Commons Image
Database. The US Government also developed a Fair Use
checker, to verify if your use is deemed fair use.

Connecting to other Adobe Products See an example of

how to do this.
Watch the video at
https://youtu.be/PPqe

You can verify if someone has embedded Copyright into an
DdM4QVA

image by using Adobe Bridge or Photoshop.

PAGE #13



Digital For all digital files, visit https://goo.gl/gsjG18

Finally, remember that certain images will fit your project, based
on the factors discussed in Lesson #1-1 and this module.

Lesson #1-2 Quick Check

Define the following terms: . 1.
Copyright Fair Use Legal Action Expand your Thinking:

Create a Venn
Diagram, comparing
- How can copyright change your design? Fair Use and

- Why is copyright important? Licensing

- What does fair use entitle?

Answer the following questions:

CASE STUDY: Obama’s Campaign Poster

Back in 2011, A street artist by the name of Shepard Fairey
created the iconic “Hope” poster, which was widely used in the
Obama campaign. Right after printing, he started to sell them on
the street, which made the posters grow in popularity. Yet, the
image he used in the campaign was a copyrighted image by the
AP (Associated Press). They both went to court to settle the
scandal. At court, the AP argued that Fairey gained over
$400,000 in sales from the hope image, while Fairey argued he
modified the graphic so much it was covered by Fair Use policies.
In the end, both agreed to settle the suit by sharing rights with
the AP, although the financial terms remain disclosed.

CASE STUDY Questions

1. What could Fairley have done to prevent this altogether?

2. Why did Fairley argue for fair use?
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#1-2 Activity A m Connect to Other Adobe Software

You will be given 3 images. Determine, using Photoshop or
Adobe Bridge, if these images are copyrighted or OK to use. If
the image is OK to use, determine the audience purpose,
demographics for the single image, etc.

Image Copyrighted? Audience Purpose? Demographic?

(o
PEPSI
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Lesson  #1-2  Activity B

Billy is a graphic designer looking to find some images to use in
his design project. Read each of his thoughts” and determine if it
would be legal or illegal, and why.

Man, this image looks amazing! Maybe | can take it from there
Instagram account, it’s no big deal.

WOW! This image that | found via the Creative Commons search
area looks so nice!

Cool! This logo looks amazing! This will surely help my client’s
reputation!

Neat! This image says nothing, so that must mean its free to
use!

Visual

Complete the diagram
The use of the

/ maee

Can be avoided by
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Fill out each box with the correct definition of each term.
Remember, these terms will come back on quizzes and future
tests.

Fair Use

Copyright

Creative Commons

Licensing

Image/Content
Fitting
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To manage a project with a e Scope Demonstrate knowledge of
client, the PMI has e Scope Creep project management tasks
developed steps to ¢ Method Mismatch and responsibilities.

efficiently manage your
project.

Understanding how to make a project work efficiently is key to
working with a client, your peers, and even yourself. Project
Management is a system developed by the PMI (Project
Management Institute) that sets key steps and strategies to
efficiently manage a project.

Is it professional?
project update - things going well!
tggedu@gmail.com
project update - things going welll
Project Update - Things Going Well!

tggedu@gmail.com

Project Update - Things Going Well!

Figure 3-1: 2 emails, which one is more professional? Why?
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Maintaining professionalism with your clients and peers is a
key strategy used by many. As a starting graphic designer, you
need to understand professionalism comes from the way you
type, speak, and your body language to the client. Wearing
business attire, spelling words correctly, and speaking
professionally are key elements to professionalism.

Scheduling frequent meetings with your client is another great
way to be professional, plus provide updates to your client. The
Pitch meeting is the initial meeting with the client to discuss the
ideas for your project.

At the Pitch Meeting,

e Talk budget for the project

¢ Discuss your target audience and demographics

e Lay out a timeline of start/end days of each step of the
project

e Discuss what they want you to make, and why they want
you to make it.

SCOpe - Project scope is the work required to output a

project’s deliverable. Change happens, and project scope
management includes the process to manage scope changes
and make sure the project will still come in on time and within
budget. The scope is often defined by a work breakdown
structure, and changes should take place only through formal
change Ctrl procedures.

MethOd MlsmatCh: Methods on

older/different scaled projects that may not work on a new
project

Figure 3-2: Terms to know when managing your project
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Scope and Method Mismatch are important concepts to
implement into your project. Knowing the effort it will take to
produce a product is important, so you can allocate resources
efficiently through your design company. Using methods, you
used on a smaller project, such as a project management
software, would be very inefficient.

Say you use Project Management Plus, designed for small scale
projects, like business cards, on creating posters for a fast food
firm. This would be an example of Method Mismatch.

Understanding your project scope can help prevent Scope Creep,
additions to a project without approval from the client that leads
to your project growing out of Ctrl. Scope Creep can be common
in many projects, and understanding and setting your scope and
proper methods before starting can be key.

Steps in completing a project (IN ORDER) (based on
PMI):

e Planning and analysis

o Design

e Building and testing

e Proofing and revising

« Implementation or publishing

These are the steps to completing a project. These are
important, as they walk designers through an efficient process of
completing a project with lots of planning and preparation.

Planning and Analysis involve the initial steps to get the
project ideas going. Some designers create Mockups or a rough
sketch of the design layout.

Design involves the overall creation. Wither it's a poster,
business card, this is where the planning is put into action.
Designers generally send frequent rough drafts through this
phase to the client.

Building and Testing are where designers start to test the

design. This is more present in web design, but can also be
applied to print designs. For instance, designers can hold focus
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groups and ask other designers for feedback on designs. After
testing, Designers send the Final Draft to the client.

Proofing and Revising come after receiving feedback from the
client. This can become one of the longest steps, as receiving
lots of feedback can be a lot to correct.

Implementation and Publishing is the final step. Based on
the client’s needs the Final, Final draft will be published either
to the web or to print. It's always good to stay in contact with
the client after publishing to see if they need anything else or
improvements.

Remember, professionalism is the MOST IMPORTANT
ASPECT OF A WORKPLACE RELATIONSHIP!

Lesson #1-3 Quick Check

Define the following terms:
Design Analysis Planning Testing Scope

Answer the following questions:

- Why would scope creep be bad?
- If scope creep occurs, what would be the best thing to do?
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Lesson  #1-3 | Activity A

Read the email from the client, and prepare a timeline using the
chart below. Some boxes may not be filled. Feel free to add
boxes, too.

From: jerry@hamburgerhawns.com
Subject: Design Information
Sent on: 1/11/2017

Hamburger Hawn’s
We need YOU to design a billboard for the 1-35 highway!

It MUST be done by February 8th, 2017.

Thanks,
Jerry

Date Item Started/Completed

1/11/2017 | Project Started

2/8/2017 | Project Finished and Submitted
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Lesson #1-3  Activity B

Fill the table out with the definitions of the key terms.

Timeline

Project
Management

Professionalism

Pitch

Mockup

Rough Draft

Final Draft
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Lesson #1-3 | Activity C

Define each of the following terms, and signify their
importance in your project.

Term Define Significance

Scope

Plan

Draft

Testing

Pitch

Communication

Scope Creep

Write
What is Scope Creep? How can it affect your entire project?
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CIMMUNITRNION

Communicating with e Communication Communicate with others
coworkers and clients e Teamwork (such as peers and clients)
frequently is a crucial e Collaboration about design plans.

element of workplace
relationships.

Communication with your clients, peers, and your coworkers is
crucial to maintaining your professional nature.

Remember some key things:

¢ Send emails/updates frequently. Don’t leave your client in
the dark. It may be your project, but it’s your client’s
design.

e Talk and type in professional ways. Using pop culture
abbreviations like “LOL!” and “OMG!” are very
unprofessional. Try your best not to use professional
abbreviations, such as R.S.V.P, D.1.Y, or B.Y.O. Take the
time to type the whole word out.

e Talk and dress in a professional manor.

Take the time to review Lesson #1-2 and Lesson #1-3, as
professionalism is debriefed more in those chapters.

Lesson #1-4 Quick Check

Define the following terms:
Teamwork Collaboration Communication

Answer the following question:

- Why should you communicate frequently?
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Lesson #1-4  Activity A

You and your co-workers are working on a project for a design
company. Below are some emails your coworkers sent to you.
Based on this, type a valid email response.

Sender: Enrique
Subject: Missing TIFF File

Hey,
I’m missing a file; do you happen to have it?

Thanks,
Enrique

REPLY
To: Enrique
Subject:

Sender: John
Subject: Hamburger Graphic

Hey,
I found this really cool graphic on copyrightedpics.org. Can | use it?

Thanks,
John

REPLY
To: Enrique
Subject:
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Lesson #1-4  Activity B

Vocabulary
Review and type the definition of all the key terms.

Teamwork

Collaboration

Professionalism

Connect to English
Rewrite the following email, and make it more professional.

Hey billy,

I was so busy last night, i reaally dont think i am going to make it last
night. Truly, i think this prj is coming together lol. Really, i think is is
coming together. 1 worked so hard in photoshop last nght. So sorry, the
wife just had a baby and its really cute. Ill send pics.

Thaks,
joan
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HODDLE 1 TESTRREY

Look at the images, and write a scenario for a business that may
use the image.

Define the following terms:

Demographics

Target Audience

Audience Reaction

Purpose

What is Fair Use? What reasons fall under fair use?

What does copyright mean? How can you avoid it/use free
images?
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What is licensing? What websites can provide licenses? What is
the best way to get a license?

Define the following terms:

License

Copyright Law

Fair Use

Image Fitting

Professionalism is important in a client-designer workspace.
Why?

When should you update your client?

When should you provide a rough draft of the project? A
mockup? A final draft?

What is a pitch meeting? What should be presented at the pitch
meeting?
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Define the following vocab terms:

Pitch

Mockup

Professionalism

Communication

Draft

Scope

Project
Mismatch

What is one difference in the following emails? Which is more
professional? Why?

Project Update - Things Going Well!

tggedu@gmail com

Project Update - Things Going Welll

project update - things going well!

tggedu@gmail.com

project update - things going well!
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Name the steps to complete a project in order, and their
significance:

Define the following terms:

Teamwork

Collaboration

Professionalism
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WISUAL EXAN > wowns o9

Use a free design service, such as canva.com, or pictochart.com
to create an infographic that describes basic US Copyright laws,
and fair use policies.

Be sure to include the following information:

e Information on modern copyright laws
e Information and policies on fair use

Rubric:

The harmony of information presented on
the graphic was well designed and well
presented.

The graphic looked clean and well
presented to the audience.

The graphic looked polished, the colors and
shape elements were well chosen and
thoughtfully presented.

The graphic demonstrated the correct
copyright definition.

The graphic demonstrated the correct
knowledge of fair use
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Before we begin... Vocab

To understand how all images work, there are some key terms
to know when working and manipulating images.

Resolution | Refers to the overall quality or appearance of the image. This
can be represented by the pixels by the pixels

Example: HD Resolution is 1920 by 1080

Pixels The units of measurement on photos.
Example: 1920 pixels by 1080 pixels

Type Symbols used to create text within an image

Raster An image which is made up of pixels; also known as a bitmap
image.

Vector An image which creates shapes through mathematical
definitions.

Object A shape which has been drawn in Photoshop which can be

moved and rasterized.

Bitmap Color mode that uses black and white values to specify color.

Render A method to preview sections of all in its final form before it
is exported.

Path A vector shape that contains no pixels. Paths can also be

converted to selections.
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Lesson BEB Activity A

Fill in the blanks with either the definition or vocab word.

Type

A single dot in a digital image that is assigned a specific
location and color value. Pixels are the base elements for
all images in Photoshop.

An image which creates shapes through mathematical
definitions.

An image which is made up of pixels; also known as a bitmap
image.

Bitmap

Path

Render

The number of pixels per square inch on a computer-generated
display. The greater the number of pixels per square inch, the
higher the quality of the image.

Word Scenario

Judy is saving a final draft of her project to send to her client.

Enrique is creating a new .psd fine that is 1920x1080.

July is creating a new image, which is made up of pixels.

Using some math, Bill was able to create some shapes on his
.psd document.

Suzy is using a certain color map while she is working in
Photoshop.
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Lesson BEB Quiz

Write the correct vocabulary word for each of the definitions.

A single dot in a digital image that is assigned a
specific location and color value. Pixels are the
base elements for all images in Photoshop.

An image which creates shapes through
mathematical definitions.

Render

An image which is made up of pixels; also known
as a bitmap image.

The number of pixels per square inch on a
computer-generated display. The greater the
number of pixels per square inch, the higher the
quality of the image.

Create a Venn diagram of Vector and Bitmaps.
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The Design Principles are e Contrast Demonstrate knowledge of
the building blocks of e Repetition basic design principles and
everything in design, in all e Harmony best practices employed in
fields. the visual design industry.

As the author of this book, writing all these lessons, worksheets,
and content, | guarantee you, this will be the MOST IMPORTANT
lesson of your graphic design career. These principles are the
fundamentals of design. The question is, what are the design
principles? Well, to put simply, these principles are the
fundamentals of design, or the building blocks of design. You will
be able to look at ANY piece of art or design, and be able to
identify the elements of design.

Repetition refers to an
element repeating more than
once on a design. It’'s good
to repeat colors, fonts, and
other elements on a design.
Having too much diversity
within a design gets very
visually unattractive and
busy for readers. Remember,
you want to make a visual
impression within 5 seconds of a patron looking at your design.
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tggEdu Educational tggEdu Educational Center

Center

Come to our center to take
tests!

11092 Center Rd.
Austin, California

Come to our center to
take tests!

11092 Center Rd.
Austin, California

Look at the 2 business cards above. While the one on the left
demonstrates repetition, the left card shows too many changes
in fonts, as well as the font size, does not repeat.

Contrast refers to the difference in color
between the foreground and background.
For instance, if | were to write this
textbook in a do you think
you could read it? The contrast between
white and yellow is poor. Having good
contrast between your background and
foreground is key to make your design
readable and visually appealing.

Figure 2-4: Demonstration of Contrast, black and white

tggEdu Educational

Center
Come to our center to take

tests!

11092 Center Rd.
Austin, California

Looking at the business card examples, the one on the right is
readble, with the element (or the text), a nice white with a blue
background. Yet, the one on the left is a dark green on a blue
background.
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@

o Contrast is one of the most important design elements in
the entire world! I remember doing Poetry Presentations in
10% grade and remembering someone people using a purple
highlight with a dark blue font. Which would look like H
Could you even read that? Now try imaging to read it from 10
feet away. You may not have realized it, but you may have
fallen to this in the past. Be cautious and aware of what you

can and can’t read!

Proximity is the principle of

000000 00 00 (0( space with meaning. It also can
be conveyed as placing related

000000 00 00 00 elements in your design

000000 00 00 (00 together. For instance, placing an
email and phone number next to

000000 00 00 00 each other makes sense. Being

000000 00 00 00 aware of what your elements

mean and convey allows for easy
000000 0o 00 00 placement of your design.

tggEdu Educational tggEdu Educational Center

Center Come to our center
Come to our center to take 11092 Austin,

California
Center Rd.
11092 Center Rd. to take tests!

Austin, California

tests!

The card on the left demonstrates a solid knowledge of
proximity. The phone number and address are grouped
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separately from the title and tagline. Yet, in the image on the

right, the description may be aligned, but they are separated,

with the phone number and address in the middle, making the
overall design look weird.

-0-0-0-00-0-0-0-0-

in ALIGNMENT Alignment refers to the overall inline

of elements. This can also refer to

_o.o_o_o-o_o_o.o_o_ elements being centered, aligned to

the right/left, or anywhere on the
page.

Figure 2-7: Example of Good and Bad alignment

out of ALIGNMENT

Scale refers to the size of certain
elements on a page. Depending on how
big or small something is what the scale
is. Sometimes, your scale should be
bigger than others to emphasize titles or
headings.

demonstration of scale with circles.

tggEd u tggEdu Educational

Center

Educational Come to our center to take

tests!

Depicted in the business cards above, the scale on the right is
good, as the title is bigger than the text that proceeds it. While
on the left, the scale of the title forces the other elements off the
card, only showing part of the title.
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There are lots more design principles in the world. Yet, one a lot
of people have trouble with is Harmony. All Harmony details are
that all parts of the image/design relate and complement each
other, it pulls the image into one unified unit.

Lesson #2-1 Quick Check

Define the following terms: . 1.
Harmony Contrast Scale Alignment Expand your Thinking:

Answer the following questions:

- Why do these principles exist? Google images of everyday designs or
- How can you apply/where do you see these popular designs, and analyze how
principles executed in reality? these principles are executed.
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Lesson  #2-1 Activity A

Name 4 design principles.

2. Which principle defines how big an object is?

3. Which principle defines the space and its relation to the
subject?

4. Which principle defines the amount of space an object takes
up?

5. Which principle defines how many times something repeats?

6. Which principle defines the alignment of elements of text on a
page?
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Lesson  #2-1  Activity B

For each element listed, find a REAL-LIFE example. It is OK if the
images are copyrighted. You can sketch in the book or use
Google.

Good Bad Good Explain Bad Explain
Example Example

Repetition

Contrast

Scale

Harmony

Alignment

Proximity
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Lesson #2-1 Quiz

For each question, pick the best element.

Principle Define

This refers to how big something is on the page.

This refers to the differences in color and background.

This refers to how aligned text/graphics are on a page.

This refers to how frequent an element/layout appears on
the page.

This refers to how close elements are to one another,
including how info is laid out on a page.

Write a 3-4 sentence summary explaining the significance of the
design principles:
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Typography and Color e Type Demonstrate knowledge of
properties add harmony e Color typography and its use in
and details to your design. e Serif visual design.

Demonstrate knowledge of
color and its use in digital
images.

Type and Color are important aspects of your design. Whether
choosing fancy fonts or attractive colors, these elements can
make or break your designs. There are a few terms you need to
know to use type and color correctly.

Types of Fonts:

Serif Fonts that look more decorative because of the serif on the
end of the letters. For Instance, Times Roman is a Serif font.

Sans-Serif Fonts that don’t have a serif on the end. This literally
translates to “without serif”.

Display Fonts that are very decorative. For instance, the headings we
use for this book are display fonts or BMB@N’MD@ @mﬂm&mw

Now that we have reviewed the types of fonts, let’s review some
principles found when formatting fonts.
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Properties of Fonts:

Hierarchy | Organizing text by importance to allow readers to easily find

information.
Leading The distance between the baselines
Kerning Amount of space between 2 letters

“To Kern” means to adjust the space between 2 letters
Tracking Amount of space between a group of letters.

There are a few rules to remember when using type and fonts
within your designs:
e Use as few fonts as possible! The more fonts you use,
the messier your design will look!

e AVOID FONTS LIKE COMIC SANS, FPAFAYR(S, AND

WINGDINGS! These are outdated and will NOT look good
on high professional designs.

e Use websites, like Adobe Typekit to find web fonts to use
in designs vs using the presents on your computer.
Remember, copyright rules still apply to font selections!

Color is another key element in the design. It’'s good to use a
single set of colors. There is some color sets, based on the color
wheel, that designers frequently default to. This also helps
increase the harmony of the design (see Lesson #2-2)

Monochromatic One color on the wheel, using various shades of one
color.

Analogous On the color wheel, creates a large triangle of colors.

Complementary On the color wheel, colors directly across from each
other.

Split Complementary | On the color wheel, creates a small triangle of

colors.

Triatic On the color wheel, creates a normal triangle of
colors.

Tetradic On the color wheel, creates a rectangle of colors.
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This is a hard concept to grasp, as they are triangles. Be sure to
use Google Images to study visuals and how the look. As well,
use the video later in the lesson to help study.

There are also some key terms that deal with color.

Hue A color or shade
Saturation The power of a specific color in an image or design
Value The light and dark values within a color.

All these terms are important to understand and grasp, as they

will help the harmony of your design, which in the long run will
make your design look better.

Lesson #2-2 Quick Check

Define the following terms:
Hue Value Kerning Tracking Display Serif

Answer the following questions:

- Why does font readability matter?
- Why does having a limited amount of fonts matter?
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Lesson  #2-2  Activity A

Use the boxes to type an example work in the provided font
type, as well as type a basic definition and use of each type.

Use/Definition Example

Serif

Sans-
Serif

Display

Should you limit yourself when using fonts?

Do opposites attract for fonts? What are some examples?

Fill out the following chart:

Definition How do you
establish?
Hierarchy
Leading
Kerning
Tracking

Define the 4 styles of fonts and their uses:
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Lesson  #2-2  Activity B

This activity follows a video, located at The Digital Way website, Module #2-3,
Lecture slides.

Answer these questions:

What is “Color Theory?”

What is a color wheel?

Define the Terms

Hue

Saturation

Value

Fill out the formulas for Harmony:

Monochromatic

Analogous

Complementary

Split
Complementary

Triatic

Tetradic

List the do’s and don’ts of color, and list the solutions.
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Lesson #2-2 Activity C @ Connect to Other Adobe Software

Now that you have understood how to use the color wheel and
color combos, you can now create your own combos based on
these rules. One web app, Adobe Color can help with that!

For this activity, you will use a web device to go to
color.adobe.com and create your own color wheels based on

these rules. Then, take the HEX codes (which look like #xxxxxx)
and write (or type) it in the table below.

The first one is an example.

Monochromatic 417F1B | 4DCCOO | 61FFOO0 | 90FF4C | 307FOO0

Analogous

Complementary

Split Complementary

Triatic

Tetraic

Conclusion:

What can Adobe Color be used for?
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There are plenty of image e PNG Demonstrate knowledge of
file types in the world e JPEG image resolution, image
which have various pros e GIF size, and image file format
and cons. Image resolution for web, video, and print.

and quality may influence
with the types of files you
use.

All images have a set of properties. Yet, these can differ between
images. For instance, a more colorful image may have a set of
different properties than an image that is just black and white.
These properties are also known as Resolution and File Type.

To identify these properties, just look at the file icon on your

computer.
. L
Dlgltal :

Adobe Adobe Goagle Drive Intro NES
Dimension CC Lightroom Item type: PNG File Startup Screen

Classic CC Dimensions: 2671 x 1177 HD
N S AL |

On Windows machines, just by hovering over an image, or right
click - properties. This may differ on Mac/Linux.
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Resolution (also known as dimensions) is the image size (width
by height) which is generally measured in Pixels. There are a
few common resolutions to remember when designing.

Width Height
HD 1920 1080
4K 3840 2160
Letter Paper 8.5in 11in
Legal Paper 8.5in 11in
720p 1280 720
Normal Photo 4in 6in
Email Header 480px 480px

When publishing your design (see Module #5), It's important to
be aware of the file type you’re going to publish and the file type
your using in your design.

Types of Files:

Define
.gif Allows for animation, or combination of pictures to create
an animation. Allows for
.png Portable Network Graphics, a very basic and easy file,

commonly used on internet

Jjpeg Joint Photographic Experts Group, allows for a lot of info in
a small file size.

tiff Tagged Image File Format, very large sizes of images,
very flexible for color (allows for better printing).

.bmp Vector, Capable of storing lots of info. File size is bigger

Raw images | Digital info from a camera, have not been processed, so
allows for raw data. Must be processed by special
software.

Lesson #2-3 Quick Check
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Lesson  #2-3  Activity A

Fill out the chart below:

Pros Cons

.gif

.png

jpeg
tiff

.bmp

Raw images

What image type would you use for the best quality, regardless
of space?

What image type would you use to print flyers to distribute at
school?

What image type would you use to upload quickly to the internet
or a webpage?

What image type allows you to animate or combine multiple
photos into one?
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Lesson  #2-3  Activity B

Answer the following questions:

e What does PPI stand for? How can it be applied to design?

e What math gets you your ppi?

e Describe how the crop tool affects the resolution:

Fill out the table. Be sure to SPECIFY your measurements!

Width Height

HD

4K

Letter Paper

Legal Paper

720p

Normal
Photo

Email 480px 480px
Header
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UUDDLE 2 TESTDRED

Fill out this table with the correct image term:

A single dot in a digital image that is assigned a specific
location and color value. Pixels are the base elements for
all images in Photoshop.

An image which creates shapes through mathematical
definitions.

An image which is made up of pixels; also known as a
bitmap image.

Bitmap

Path

Render

The number of pixels per square inch on a computer
generated display. The greater the number of pixels per
square inch, the higher the quality of the image.

From the words above, insert the one that defines the type of
file.

Word Scenario

Judy is saving a final draft of her project to send to her
client.

Enrique is creating a new .psd file that is 1920x1080.

July is creating a new image, which is made up of pixels.

Using some math, Bill was able to create some shapes on
his .psd document.

Suzy is using a certain color map while she is working in
Photoshop.
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In the table, name all the principles and their definition.

Principle Define

Fill out this table:

Use/Definition Example

Serif

Sans-Serif

Display

Fill out the following chart:

Definition How do you establish?

Hierarchy

Leading

Kerning

Tracking

Should you limit yourself when using fonts?

Do opposites attract for fonts? What are some examples?
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What are the general font styles?

What is the most important aspect of typography?
What fonts should you avoid when creating designs? (name 3)

What is “Color Theory?”

What is a color wheel?

Define the Terms

Hue

Saturation

Value

Fill out the formulas for Harmony:

Monochromatic

Analogous

Complementary

Split
Complementary

Triatic

Tetraic
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List the do’s and don’ts of color, and list the solutions.

Pros Cons

.png

Jpeg
tiff

.bmp

Raw images

What image type would you use for the best quality, regardless
of space?

What image type would you use to print flyers to distribute at
school?

What image type would you use to upload quickly to the internet
or a webpage?

What image type allows you to animate or combine multiple
photos into one?

What does PPI stand for? How can it be applied to design?

What are some common resolutions?
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UISUAL EEAN > wyoms o2

You will be creating another infographic or poster to demonstrate
5 (1 per poster) design principles of your choosing. You may use
canva.com or pictochart.com.

Requirements:

o At least 2 copyright free images demonstrating the image
on each poster. (SCHOOL APPROPRIATE! That means, no
bikinis, shirtless men, etc. If you're doubting if you can use
it, DON'T or ASK!)

o Definition and Title of the element

e All posters should be creative, and should, in the sense,
demonstrate all the principles with your placement of
elements.

e Choose only 1 COLOR PALETTE (see lesson #1-3) we have
learned from the color wheel to use!

e Choose only 3 FONTS FOR ALL POSTERS, and STAY
CONSTANT!

YOU WILL TURN IN 5 IMAGES!

Rubric:

The elements demonstrate the knowledge of the principles

All 5 principles were correct in definition and examples.

The color scheme matched what was specified.

The typography matched and was well executed.

The file type that was submitted was appropriate for this
project.
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Adobe Goals

The Photoshop interface e Layers Identify elements of the
has a lot of functions e Adjustment Layer Photoshop CC user

ticked into the simple Ul, e Rulers (Ctrl+R) interface and demonstrate
and has many panels knowledge of their

functions and define the
functions of commonly
used Panels, including the
Properties, Layers, Brushes,
Adjustments, and Type
panels.

preforming different
functions.

Lectures will work a bit differently beyond this lesson. Instead,
you will be walk through a tutorial within Photoshop. That’s
right, you get to open and use Photoshop now! Be sure to follow
each step, so you can learn certain functions of the program.

You Will Need: Al files can be

found on The
Digital Way
One .psd File website.
“Lecture psd.psd”

PAGE #61



Digital For all digital files, visit https://goo.gl/gsjG18

First, let’s start by opening
the file in Photoshop. All you
will see is a Polygon.

Through this tutorial, we will
identify some properties of
the workspace, and how to
use them.

First, let’s measure this shape. Go to View, Rulers, or use
CtrI+R, or Command+R for Mac.

Well, we want to use some better measurements. Let’s change
the ruler to Centimeters. Right-click on the Rulers and click
Centimeters.

Now that we have the rulers in centimeters, let’s try turning on
and off the polygon. Find the “Layers” panel, and click the

Eye icon on the “Polygon 1” layer. Notice how the layer
disappears from the canvas.

Go ahead and turn the layer back on by clicking the eye icon
on the “Polygon 1 layer.

That color looks kind of bad for a Polygon. Go ahead and select
the polygon layer. On the toolbar, find the swatch panel, and

choose the foreground color (or the one in the front). Change
it to a Light Blue (or HEX code #94d6e4) and confirm the

change.
Wait. The color didn’t change? Oh. Well, that’s the thing, you Sometimes,
need to select the shape. We just selected the layer, not the with the shape
O . layer selected,
shape. Go ahead and locate the Shape tool &8 (we will
) ) you can use the
discuss tools in the next lesson). “Properties”
panel to change
the color.
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Now that the shape is selected, we can use the workspace at the
top to change the fill.

File Edit Image Layer Type Select Filter 3D View Window Help

O ~ Shape  ~ Fill:

Stroke: 1 px v =——~ W: 160831 G® H: 1607.53

Lecture psd.psd @ 50% (Polygon 1, RGB/8) * *

Go ahead and locate the Fill option on the top bar.

Once clicking, this pallet menu will be
loaded. The most recent colors will be
shown at the top. Since we made that
“mistake” earlier, the color should be the
first color.

M7z =

Recently Used Colors .
| HEEE B B

H'E EEEEE
EET N

.l |
[ | [ . i |
[/
[ | Wl
Just in case the blue is not in the recent
colors, Change the to a Light Blue (or HEX
code #94d6e4) and confirm the change.

This is what the shape should look
like now. Now, we are going to add a
filter to the image using the
Adjustments window

Add an adjustment

. Open the Adjustments panel, either by
0 wile A P71

going to window 2> Adjustments, or by
looking for the panel Adjustments on
the right side, above the layers panel.

B O HE
€EEX3

For all digital files, visit https://goo.gl/gsjG18

TIP: You can
adjust and
customize your
workspace under
the Window tab.

TIP: You can
remove
“Swatches” by
right clicking
on a swatch.
Plus, clicking on
the Gear icon
allows you to
save your
current layout
and share.

TIP: Don’t see
the adjustments
panel? Add it
under the
Window option.

PAGE #63




Digital For all digital files, visit https://goo.gl/gsjG18

Choose the brightness/contrast adjustment m and it will
create a new layer. All the layers below this “adjustment” layers
will be changed based on this adjustment. A new window, known
as the adjustments layer, will come up. Try sliding the
brightness and contrast up and down, and notice the changes.

Click the “Auto” button on this panel. This will adjust the settings
automatically. Verify the brightness is 31 and the contrast
is 56.

Now, the shape should look brighter. There are a few others
panels we will discuss before finishing this lesson up.

The brushes panel allows you to add and create brushes. For
some lessons, you may use the brush tool to create and choose
brushes.

Let’s try using the brushes panel. Select the Brush Tool
and open the brushes panel. We’re going to create a new brush.
Open “Brush Settings” on the brushes panel. Create a
brush with the following requirements:

e Shape Dynamics: Jitter 50%

e Dual Brush: Size 30px

e Noise: Checked on

e Color Dynamics: Hue Jitter: 20%

To save this new brush, click the New icon E and name it
“lecturelbrush” and make sure “Include Tool Settings”
and “Include Color” are checked.

Select a color, and try painting on the shape. Notice how that
differs from a normal brush? Undo the changes of paint until it’s
gone.
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Character Paragraph ¥ =
' The character and paragraph panel allows

Rleny MR you to manipulate the type properties.
L 17.01pt v 2 (Auto)
V/A Metrics 0
1T 100% l-l 100% Remember the terms Kerning, Tracking,
A2 Opt Color; R R

v and Leading? This panel allows you to

TTITT: TTT T : ; ;

edit and manipulate these properties.
fi o & ada |5t 1

Enaglish: USA ~ @3 Shamp

Let’s try using the characters panel! Locate the text tool ,
and click on your canvas to create a text box.

Type “shape” on the canvas. Then, go to Window and open the
Characters panel. With the text selected, edit the properties to
the following:

Character

Paragraph
BalboaPlus ~  Primary

7' 50pt & 16pt
V,/ﬁ Metrics 10
1T 100% X, 100%

A2 opt Color:

T TTIT T'T. T

0 pt

Hyphenate

English: USA ~ &g Sharp v

Notice how the text changes. Fell free to try manipulating any of
these measurements and see the changes.

And that’s the workspace! We covered some common panels, yet
as you delve into these lessons, you will get to know more of the
workspace through using them for various tasks.

Lesson #3-1 Quick Check

How do all these panels differ?
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Lesson @ #3-1 Activity A

Look at the provided image, and describe the basic functions of
each space.
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Lesson  #3-1  Activity B

Vocabulary
Using the following table, describe the following terms.

Properties Panel

Type Panel

Customize

Adjustments
Panel

Layers Panel

Brushes Panel

Synthesize

Read the prompt, and using your Photoshop knowledge, describe
what happens next.

Bill is customizing a panel to meet his needs.
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Adobe Goals

The heart of Photoshop e Selection Define the functions of
comes when use tools and ¢ Quick Selection commonly used tools,
create selections. It's best e Magic Wand including selection,

to know all the tools and drawing, painting, type,
decipher what tool is best and vector shape tools.

for what job.

. Al fil b
YOU Wl” Need: founzj(:)i?:e )
— = ' Digital Way
One .psd File One .jpg File website.
“Lecture psd 2.psd” “hanks.jpg”

In this lecture, we will discuss all the tools Photoshop has to
offer.

Open the provided file. Notice
this image includes 4 shapes.

We will use these shapes to
create a sunshine with a face
in the middle.
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First, let’s learn to duplicate a shape. Select the layer “A” in the
layers panel. Right Click and click Duplicate Layer.

The shape is duplicated. Do this to create rays around the sun.
Your image should look like one depicted to the left.

Next, we need to rotate the triangles to make the triangles look
more like rays from a sun. To do this, we will use the Free
Transform tool. Select a ray, and go to Edit (in the File
Window), and click Free
Transform (or click
Ctrl+t/Command+T). Rotate all
the rays to make the base of the
triangle face the circle.

Your image should look like the
one to the left.

Now, we are going to select Tom Hank’s face and paste it into
the sun. Open Hanks in a new window by goung to File 2>
Open, and locating the file.

There are many ways to select items through a lot of tools. Let’s
play with some selection tools to get a feel of whats best for the
snerio.

Locate the Lasso tool E The lasso tool allows you to create a

selection by “lassoing” a part of an image. Let’s try lassoing
around Tom’s head.
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Once lassoed, a selection will be generated.
Copy the selection and paste on the same
document. Now, turn off the background
layer (eye in layer panel).

The image to the left is what the lasso tool
produced. It’s not the best, but it could be
better. Undo (ctrl+alt+z) until the layer
goes away.

Up next is the Magic Wand . Try
selecting a part of Tom’s face, then Copy,
Paste, and view the selection you made.

Well, that does not look right. Let’s try
getting to the quick selection tool. Go ahead
and undo the selection.

Now, hold down (or right click) the Magic
Wand tool, and select the Quick
Selection tool . This is like a brush for
selecting. Brush over Tom'’s face and
copy+paste the selection.

Well, that looks like a pretty solid selection.
Now, let’'s do a few edits before making Tom
the sun.

Let’s add an adjustment layer of Hue/Saturation. Set the hue to
+33, saturation to +100, and lightness to +30.
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This will make Tom’s face bright, like
the sun.

ol
i

e

Remember back in previous lessons
about the definitions of hue and
saturation? The lightness can also be
known as Value.

-

Next, let’s prepare to make Tom a part of the sun.

Go to Edit > Canvas Size. Change the measurments to Width:
6cm and the Height: 10cm. This will center the head on the
canvas. This is a good way to adjust the canvas if you crop an
image. And that is exactly what we are going to do.

Locate the Crop Tool . Crop the
canvas so it just is Tom Hanks.

After cropping, the image should look
like to the left.

Now, we will select the image using
another tool.

Locate the Rectangle Marquee tool E and select the entire
image. Make sure the head layer is selected and not the
background. After selecting, go to Edit > Copy Merged. This will
copy your selection. (CtrlI+C WON'T WORK here)

Next, head back to the sun graphic. Select

the circular part of the sun. After selecting

the circular part of the image, go to Edit 2>
Paste Special = In Place. This will paste
your image into the circle.

PAGE #71



For all digital files, visit https://goo.gl/gsjG18

Go to “Free Transform” and make
the image fill the entire circle.

Go ahead and save the .psd.

On the next page, there is a quick diagram of all the tools and
functions. Note that there are A LOT more tools than whatwe
just preseted. As you go through the activities, you will start to
discover more functions of the tools.
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Let’s review some of the other tools and there functions.

Move Tool: Moves elements on the document

Lasso Tool: Selects a free-formed part of

PE—
- Marquee Tool: Selects a geometric part of
-

+— |

Magic Wand: Selects a color/similar area of

Eyedropper: document
4 selects a

color of the Quick Selection: Selects an area determined by
user

Brush: Paints on the document

Clone Stamp Tool: “Clones” another element,

Eraser Tool: Erases part of the layer

Paint Bucket: Fills selected areas

) § Text Tool: Type on your document

Pen: Create custom shapes and paths

Path Selection: Selects paths

Shape Tool: Creates shapes

Hand Tool: Pans over parts of image

Zoom Tool: Zooms on a part of an image

YES, there are more tools. See more tools online
at https://goo.gl/3fUZbq
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Lesson  #3-2 Activity A

Using the start files, follow the directions to create a new
image.

1. Opening the Image

1. Drag and Drop “puppy.JPG” into Photoshop. DO NOT create a new
document

2. Checking for Copyright

3. Go to File --> Info, and check for Copyright.

2. Selecting the Dog

1. Use the “Quick Selection Tool,” by holding/right clicking the
Magic Wand tool, and select the dog’s head.

2. Copy (ctrl+c/command-+c) the dog’s head, and paste
(ctrl+v/command+v) back onto the palette.

3. Turn off the background of the image by using the eye icon in the
layers panel. Refer to FIGURE A-1 for what your workspace
should look like.

3. Adding a Background to the Dog Head

1. Drag and Drop “sunny.jpg” into Photoshop as a NEW PROJECT,
NOT TO THE CURRENT WORKSPACE. (or FILE --> OPEN, then
select the “sunny.jpg”)

2. Go to File --= Info, and check for Copyright.

3. Use the “Rectangle Marquee Tool” to select the entire image. Copy
(ctrl+C or command+c or file-->copy) the selection

4. Paste the image into “puppy.JPG”

5. Position the background behind the dog heads using the Layers
Panel. Refer to FIGURE A-2 for what your workspace should look
like.

4. Position the Background

1. With the “Layer 2” or Background selected, use the Move tool to
move the image in view of the tree.

2. Go to Edit, and Free Transform to position the entire image on the
canvas (this WILL look warped, but it is OK for now) Refer to
FIGURE A-3 for reference.

5. Adding Text

1. Open the Type Tool.

2. Drag the Text tool onto the sky, and within the new text box, type
“Olly” into the box

3. Change the Size to 36pt, the Minion Pro font, a center alignment,
and a color of #f06838

4. Conform the changes, and verify that your window matches
FIGURE A-4.

6. Customizing Text

Right click the text layer, and click “Blending Options”

1. Check Bevel and Emboss, with a Depth of 1000%, a size of 5px
and Opx for soften. Notice the changes.

2. Check Drop Shadow with an opacity of 100%, a distance of 4px, a
spread of 1%, and a size of 8px.

3. Check Stroke with a size of 6px, outside, and an opacity of 100%
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4. Confirm all changes, and click OK. Make sure your new image

matches FIGURE A-5.
7. Adding a Gradient

1. Use the gradient tool, use the upper toolbar to select the type of
gradient you want, which should be a Black and Transparent
gradient.

2. Create a New Layer, and move it to the top of the Layer Window.

3. With the new layer selected, from the bottom left to the upper
right, drag the tool. Confirm your changes match with FIGURE A-
6.

FIGURE A-1 FIGURE A-2 FIGURE A-3

FIGURE A-4 FIGURE A-5 FIGURE A-6
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Lesson #3-2 | Activity B

Using your Photoshop skills and start files, mimic the following
graphic. You may use your own font, colors, BUT MUST MIMIC
THE LAYOUT, including ERASING DETAILS!

Pay attention to all the details while you complete this
assignment.
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Lesson #3-2 | Activity C

Using the provided start files, follow the steps to create the
design.

1. Open “Activity C Start 3-2.psd” into Photoshop.

2. Change the circle color to a dark green color.

3. Change the letter spacing of the words “Old Soda Shop” to 160, so it
matches the width of the main title.

4. Change the text alignment to right.

Open “Tessie.jpg” in Photoshop.

Equip the Ellipse Marquee tool (hold down/right click the rectangle

marquee tool)

7. Start in the center and hold alt.

This allows the circle to expand around where you started.
Try to create a full circle around the hands WITHOUT going off the canvas.

8. Once you’ve made a good selection Ctrl+C, or copy.

9. Go back to “Activity 3-2 C Start” file and paste the hands image on the
canvas. Position it to the left of the words, and shrink the image so it
fits using the Free Transform option.

10.Bring the text back onto the ellipse, so the white text does not blend
with the background.

11.Make the text smaller so it fits into the ellipse (yes, you could also do
this with the Free Transform tool) -lc—)hiiz\r/mali)%ks like

12.Select the text and use the Warp Option to apply a “Bulge” effect with thFi)s:
a +50 bend.

13.Use the Text tool to add a new line of text that says, “Serving Sodas to
you and your Grandma since 1885!”. Make it center-aligned, the
Baskerville Old Face font family, regular.

14.Go to Blending options by right clicking the text layer in the layers
panel.

15.Check the “Drop Shadow,” and make the drop shadow Black, a opacity
of 41%, a 90 degree angle (using global light), a distance of 3px, a
spread of 20%, and a size of 6px. Click OK.

o o

16.Go to Image > Canvas Size, and change the height to 10 Centimeters.

17.Create a group of elements by selecting the layers of text, the image, The Group Icon
the ellipse, and the title text by shift clicking all the images in the looks like this:
layers panel, and clicking the group icon. (you can also right click and
glick “Group from Layers”) H

18. Shift click all the elements in the group and move them to the top of

the page, while centering it in the center of the canvas. (use the pink
guides to help you)

19. Create a text box (by using the text tool, and dragging across the
page. The next page will detail what you need to put in that text box.
While dragging the text box, note the pink margins. Try to align the text box
with the outer left edge of the circle.
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Text Box #1:
Our Locations:
Cafe in the Bronx
1300 Maple Street
New York, New York
Seasemie Avenue
1923 Abbibile Lane
Coffee, Ohio

20.Right click the text box layer you just created in the layers panel and
click “Duplicate Layer” to duplicate the text box.

21. After duplicating, drag text box to right align to the ellipse.
Notice the guides in relation to the ellipse.

22. Type the following in the text box:

Text Box #2:
Contact Us:
Cafe in the Bronx
(813) - 818 — 9183
Seasemie Avenue
(891) - 819 - 8281

23. Change the header of the Text Box to a larger font to make the

header bigger than the body of text.
24. File & Quick Export as PNG

Below is what the final image should look like:

Our Locations:  Contact Us:

Cafe in the Bronx

Cafe in the Bronx
(813) - 818- 9183

1300 Maple Street
New York, New York

Seasemie Avenue

Seasemie Avenue (891) - 819 - 8281

1925 Abbibile Lane
Coffee, Ohio
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Lesson #3-2 | Activity D

Vocabulary
Define each word, and the significance it has.

Magic Wand

Quick Selection

Brush

Type Tool

Blending
Options

Connection to Art
How does Photoshop and Physical art differ? How are they
similar?
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Adobe Goals

Using filters and masks can e Layer Masks Demonstrate knowledge of

enhance your image and e Filters
make some functions in e Brush Tool
Photoshop easier.

patterns.

In the last lesson, you learned about Photoshop’s tools and their
functions. In this lesson, we will cover other useful tools to help
in your photoshop endeavors.

layers and masks. Manage
colors, swatches, and
gradients. Manage brushes,
symbols, graphic styles, and

You Will Need:

One .jpg File
“landscape.jpg

One .png File
“dino.png”

In Photoshop, open “landscape.jpg” and “dino.png”.
Remember to put them in separate windows (don’t place the
file).

Turn on the rulers, see Lesson #3-1, if they are not on already.

Go to “dino.png” and use the Quick Selection tool u to
select the dino.

After selecting as much as you can, look for the
option. This will allow us to refine the mask.
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Paint over areas you want to keep. Press Alt or use the

option to select between areas to keep and delete.
This option will allow you to refine your selection to take out small pixels of
your selection.

Next, copy the selection, and
paste into Landscape.jpg. Use
the free transform tool to scale
the dino into view.

Try to position it like the image
to the left.

Next, we will introduce masks. Masks are a way to hide a part of
an image behind another image. These masks are handy to
make an image fade on an edge, or just to hide a part of an
image.

Let’'s add a layer mask. For this, let’s review the layer
workspace.
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Layers

O Kind vvE@TOR®

Filter Layers

Normal v Opacity: 100% | ~

Change Transparency

lock: i » « ™ & Fill: 100%

e
o Layer 1

Background ]

Locked Layer

TO UNLOCK:
Double click the Lock
or Right Click > Convert to Smart Object

Link Layers / \

Add a Layer Style Delete a Layer

Add a Layer Mask

Create a new

Create a Layer
Group

Add an Adjustment
Layer

The bottom bar is very helpful for adding layer masks and
quickly adding adjustment layers. For this, make sure the Dino
layer is selected, and click the “Add a Layer Mask” E option.

Notice in the layers panel how a white box popped up next to the
layer? This is the Layer Mask window, indicating a layer mask is
ON for this layer. Now, we will use the Brush Tool to create
the mask.

With the brush tool in use, make sure the foreground color is
black, and the layer mask is selected in the layers panel.
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First, we need to change the brush to make the edges appear
softer. Go to the brush size panel , and change the
hardness to 0%o

Paint on the Dino so that he appears to be hiding behind
the first mountain. If you mess up, change the foreground
color to white, and change your brush size.

Make sure
yours looks
like the one
to the left.

Now, go to File - Quick Export as .png, and that finishes this
lecture.

Another important thing to know is using the swatches
and graphic styles panels in Photoshop.

See the digital presentation online for more info on
these panels and how to use them.

PAGE #83



Digital For all digital files, visit https://goo.gl/gsjG18

Lesson #3-3 | Activity A

Follow the provided directions and your knowledge of
Photoshop to complete the final product.

1. Drag and Drop “tom.JPG” into Photoshop.

2. Drag and Drop “alec.JPG” into Photoshop.

3. Navigate to “tom.JPG” Use the lasso tool to select Tom’s face, NOT
his hair, just the eyes and the mouth. After selection, copy
(ctrl+c/command+c).

4. Paste (ctrl+v/command+v) Tom onto “alec.JPG” and resize, so that
Tom'’s face lines up with Alec’s. You may want to reduce the Opacity
of Tom, so you can line up efficiently.

5. Unlock the “background” layer, which should be Alec’s photo.
Duplicate Alec’s photo (on layers panel, right click-->duplicate).

6. Back on Tom'’s cutout face, use a selection tool to select the ENTIRE
face (tom’s)

7. Navigate to the FILE bar, and find “Select” Go to Modify-->Contract.
And use 5px as your value, click OK.

8. On “Layer 0 Copy” or the copy of Alec’s face, with the selection still
selected, click DELETE. This will delete the selection you just made
from Alec’s face.

9. Select “Layer O copy” AND “Layer 2” by Ctrl+click the layers.

10. With the layers selected, go to your file bar, go to Edit - Auto Blend
Layers, and use the “Panoramic” option. If all goes well, you will
have an Alec Hanks!

11.Using the Text Tool, add your first and last name to the image in
your choice of font. Make sure it is visible.

12.As always, quick export as PNG
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Lesson #3-3 | Activity B

Using a tutorial video, you will learn how to use masks to cut See the

out hair. Use the provided model photos on The Digital Way tutorial video

Website. at
https://youtu.be/
TJR20e7JcBg

You will use the same technique of “Select and mask” like you
did in the Lecture.

Lesson #3-3 | Activity C

Fill in the table with the correct vocabulary definitions:

Layer Masks

Ruler Guides

Rule of 3rds

Auto Blending

Lasso Tool

Swatches

Color
Management

What Photoshop tool could you compare to real life?
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Lesson #3-3 | Activity D

Using your knowledge of Photoshop and the provided Start File,
follow the directions to create the final image.

1. Open “pet.jpg” in Photoshop

2. Apply a Filter of “Grain” by going to Filters > Filters Gallery, with a

intensity of 28 and a contrast of 37. Change the Grain type to Vertical.

Now, let's change the dog’s fur color. If the layer is locked, unlock it.

Go back to the Filters window, and press the eye to turn the filter off.

Select the dog, using the selection tool of your choice.

Look for the “Color Replacement Tool” and paint over your selection in a

blue color.

Adjusting the Tolerance may get the fine details.

Deselect your selection.

Use a Selection Tool to select the computer.

9. Use the Color Replacement tool again to paint the computer red.

10.Deselect the selection of the computer and select the small wallet/phone
to the right of the computer.

11.Use the Color Replacement Tool again to paint the wallet green.

12. Deselect the wallet selection, and create an adjustment layer (Layer >
New Adjustment Layer - Vibrance)

13. In the Properties Panel, change the vibrance to +78, and the saturation
to -11.

14. Cut out the blurred background.

15. Open “arch.jpg” in Photoshop

16. Select the entire image, and Ctrl+C, or copy

17. Paste the background to the image, and reorder the layers so the dog
layer is on top.

18. Export Quick as a .png

o0k w

© N

Your final image should look like this:
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HUDDLE 3 TESTPREY

Look at the provided image, and label each panel.
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What panel would allow you to change or edit colors?
What panel can you change or create new layers and masks?

What panel can you change your tools on

Look at the provided image, and describe the basic
functions of each space.
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Using the following image, label each tool and the function it
has.

L ez Normal Right Click Function
2 -.f::;I ks 1
I t—d,
3 »"| = 2
[ N 3
3 T, 4
6 —r". 5
7= 6
0 & a
1 _. 10
12 | %) 11
. & .
138 .
147,71, 13
154, ». 14
168, = 15
l (% 16
I <3 —
W
! r
.S 19
u 20

PAGE #89



P‘"‘t) Digital For all digital files, visit https://goo.gl/gsjG18

How do you customize the workspace?

How can you rearrange your workspace?

How do you turn on your rulers/guides? How can you change the
measurement?

What is the sole purpose of masks?

What color deletes/erases on the mask? What does the inverse?

How do you change/manipulate colors? What workspace panel
allows you to do this?

How can you manage gradients? What is a gradient?

What is a swatch? Where can you change/select swatches?
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Using your knowledge of Photoshop and copyright
information, you will be creating a 3-page menu for a

restaurant client.

Ensaladasy Parg los

Sopas ninos

mmuwp;:nn&‘ Szladsareheshly Chi cﬁm&t ?ﬂ 1 m

Taco, Taco Salad! $5.81 yor i Some dr iod hcks

Ao olcen Lo

Me:ucano Ensalada = $4.09 Hamhurger $6.90

uﬁﬂ%lmmmww “"'""‘mf""“"""“!{

Tossed and resh greens, eef “512

and Ing.

Csaad - $520% M“ﬁ&?%gﬁ

:n‘:rnmcanplm our salad is 0st cheesiest macs.

Bl“'s Pure Salad $4.04 Hambui r'ﬂ/ Cheese $7.99

s g'w dressin aﬂd E?mupa Mm&

wulduillvmaﬂﬂf" \ mgamw with cheese.

Tortlla Soup S489 %% Meicano Meatballs ~ $4.99

i T L

:I Is soup home by 0 ek
PastaPesto  $7.99

Desserts s

Zac's Tres Leches

“Best,Cake. Evr,"-Joe D,

Fried Ice Cream

Ieg cream surrounded by com

flakes.

R gt

s,

RUBRIC:

Your menu must include:

o 3 Pages, excluding cover (3
separate images turned in
together)

e 3 Images of Food (remember,
copyright!)

e Text, font is large enough and
readable by viewers

e At least 1-layer mask

Be sure to export as a PNG, AND
send the .psd file with your menu.
THIS WILL BE THE FIRST TIME
YOU CREATE A PROJECT, so
follow these directions:

e Open Photoshop

e Click “New Project”

o Make the dimensions Letter
(which is under Print, or just put
in 8.5x11in)

e Click OK

You will need to do that 3 times.

15

20

The images demonstrate the 5 principles of design

All requirements were met in full

No images were copyrighted

The menu was creative and well designed.

The menu had corrected grammar, spelling, and good English.

PAGE #91



Heart of
Photoshop



STARTHIE FROA SERATE

Designers who are creating e Place Create a new project.
original designs start with e Document Import assets into a
a blank canvas and drag project.

and place elements on the
canvas.

Photoshop is not just for editing and manipulating photos, it can
also be used to create original graphics, like you did in the Visual
Exam for Module #3. For this lesson, we will simply learn how to
create a new document.

First, when opening Photoshop, you will be prompted to create a
new document. You can also go to File 2 New to create a new
document. Then, you can select a present resolution or type in
your own resolution.

After that, you can save the resolution as a preset, and name
the preset for future use.

When you have your new document open, it’s time to place an
element, like a photo. Go to File > Place and locate the image.
You can also drag and drop the image onto the page.

Finally, review concepts from Module #3, like masking,
selection tools, and free transform.
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New Document x

. Presets on

Untitled-1 wla

@ Recent

top, customize
on the right.

Let's start something new.

i

Pixels/Inch

RGB Color

Landscape, 23

When creating a new document, you don’t have any elements to
start with. To add external elements, like photos, go to File >
Place, or just drag and drop.
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Lesson #4-1 Activity A

Make a Monster!
You will create an original monster, ONLY USING TOOLS INSIDE
PHOTOSHOP!

Getting Started:
e Default Photo Size

Requirements:
« Be Creative!
e Only use tools inside Photoshop!

Lesson #4-1 Activity B

You will create a portrait of yourself, in a unique way.
Use a web service, like YouTube to look up Photoshop Portrait

Tutorials.

You will need a photo of yourself.
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Lesson #4-1 Activity C

Using you Photoshop skills, follow the directions to create the
design.

1. Create a Letter Document in Photoshop
2. Use the Rectangle Shape tool to create 4 shapes across the canvas. Notice
how the 4 rectangles won't fill the entire canvas.

3. Use the crop tool to make the canvas smaller, so the rectangles fill the
entire canvas,

4. Open Hanks.jpg into a new window

5. Select Hank’s face and body, or delete the background

6. Copy Hank’s body

7. Back in the new document, select the first rectangle on the left, and Paste
Into the rectangle.

8. Use Free transform to make Hank’s fill the entire rectangle.

9. Duplicate the rectangle you just pasted into, and place the layer on top of

the hank’s rectangle.
10. Change the Opacity to 50% of the top rectangle.
11. Lock the rectangle layer, NOT the photo layer.

Complete these steps for each photo and each rectangle.

Your image should look like this, the colors may differ
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Use basic retouching

There are small features to e Filters
remember to add more e Graphic Styles techniques — including
filters and “pizzazz” to color correction, blending,
your image. clonlng, and fllter_s —
to manipulate a digital

image.

In Photoshop, there are a few ways to make your images,
projects and elements better, by using advance techniques. We
recommend watching some YouTube Videos for this section, as
watching how to do it vs explaining in text is better.

This section will reinforce skills you’ve learned in the past
section.

Watch the videos at:
https://goo.gl/YvVYky
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Lesson #4-2 | Activity A

Colorful Scene!

Using the tips on Color Correction you just learned, you will use
one a web image to correct the color and add a filter to make
the image LOOK BETTER THAN IT DID BEFORE.

Requirements:
e« Use at least 1 filter
e Color Correction is Required
« 1 Adjustment Layer, see Module #3
e« The image MUST look better than it did before.
o Attempt in Cloning or Blending

Post Project

Quick save as a .png file, AS WELL, you will complete a Write Up
sheet, explaining the process of creating the image (see
resources in the back).
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Follow the steps, using the provided start files, to create the image.

1. Open “senior.jpg” in Photoshop.

1.

Use a tool to cut the seniors out of the
background. Delete the background.

2. Open a new Letter sized document.

1.

2.

Paste the Senior picture onto the letter paper. Put
in the lower left-hand corner.

Apply a layer mask to the image. Paint the top of
the head, so the hair looks more natural, not a
straight edge.

. Use the Type tool, and type “Senior Activities” in a

76pt, Baskerville Old Face font style. Center align
the text.

Using the Constantia font style, type the following
phrase with the same alignment:

Are you bored?
Want to get off your rocker?
Now is the time!

. For the text above, make the less prominent

message 46pt font, and the overall message 76pt
font.

. Below the text box from above, add another text

box. Using the same font face as above and a size
of 26pt, use this text, with the same alignment:

Off My Rockers! Senior Recreation Center
781-8381-3899
West Avenue, Austin, Texas

7.

8.

9.

Apply a background to the entire image using the
hex code of #78d4e8

Add a stroke bordering the entire image of 7px,
white.

Make the image of the seniors go behind the
stroke.
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10. Apply a color balance adjustment to make
“senior.png” look more like the background,
making it bluer.

11. Use the Custom Shape tool to add a light bulb
icon to the right of “seniors.png”

12. Move the light bulb icon behind the seniors.

13. Add a copyright to your image, using your
name.
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Adobe Goals

Create a vector drawing,
such as an icon, button, or
layout.

Creating vectors, or e Vector
custom shapes and icons is e Pen Tool
mainly done using the pen

tool and its variants.

In this lesson, you will learn how to use the Pen tool to create
vectors and icons. First, let’s practice with the pen tool.

Open the “Pen Practice.psd” and follow the directions bellow:

Once open, on the top, it will show you how to create the shape.
I'll explain how each shape is formed here.

First, find the Pen Toolm, and go to Artboard land prep to
trace. When you click on your mouse, you create an anchor, or
the end point of a line. The space between the two anchors is
what creates the line.

UMBEQ Noti_ce th_e
. straight line. The
pen tool creates
lines all variants,
whether curved or
crooked. Holding
the SHIFT key

ensures your line
is straight.
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Next, let’s try a zig-zag motion. Click on wherever there is a up
or break in the mountain, remember not to hold down the
mouse, that will be in the next step.

TRABE:

Clicking
multiple times
creates one
unified shape,
joining the
anchors
together to
create a
closed shape.

Now, let’s create some

HB}&@E“ curves. Since you’'ve learned

? how anchor points work,
now we will learn what a
breezer (or slope) is. Image
it like a wall, and the line is
like a ball, bouncing on the
wall. The breezer helps

create the curve.

The breezer differs than a
normal line. The ends have
opened, hollow circles. To
create a breezer. HOLD the
mouse down, and the ends
will extend proportionality.

Taiss:

Now, add an anchor point when
the circle ends, and add another
breezer. The space between the
2 breezer anchor points creates a
curved line, based on the height

| and angles of the breezes.
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Using the breezers is a
process of trial and
error, so keep at it as
you finish the two
remaining lines.

This one is more of a
trial and error. Start by
creating a straight line,
then add a negative
breezer, which is quite
long, to create that
slanted slope. Note that
you only need to create

one breezer, as shown
\ in the picture.

YA

(=N

And voila! The path is
complete. The peen tool
takes some getting use
to, but once your use to
it, it can do some
amazing things! Next,
we will intro you to the
Curvature pen tool to
create vector icons and
shapes.
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You Will Need:

One .psd File
“Lecture psd 3.psd”

Notice that the file is blank. This is on purpose. First, find the
pen tool n and hold the pen button, and select the Curvature
variant.

Now, with your mouse, click points to create a circle. These
points are called Anchors. The curvature pen allows us to add
curves to the pen. The line created between these anchors is
called a Path.

Now that we have a path, let’s try typing some text onto the
path. Use the text tool to type onto the path. An icon will appear
(swirly line) when you can type.

\Q@ -‘-”9/(" Type something cool on the path.
~ 2
— The text will wrap around the circle path

. you created.
N

Undo so the text goes away. Now, let’s convert the path to a

shape.
Reselect the Pen tool. Then, go to m option, and select
“Shape” from the drop-down menu.

Nothing happened? Well, this option is to change your pen tool’s

function. To convert a path into a shape, we will have to try
something else. Undo until the original path returns.

option.

Select “Make: Shape” and the path that is selected should turn
into a shape!
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Now we need to edit the shape

properties. Either use the “Properties”
panel, or use the “Shape” tool to edit
‘; the fill. Make the fill a bright yellow.

See the image to the left for what your
shape should look like.

Now, change the tool to the Pen tool . On the circle, create
a mouth.

When you hold the pen tool, it will create a curve. It’s best to
click to add anchors, and a shape will form from those clicks.

Next, use the curvature pen tool to create circle for an eye.

Now, to create the other eye, we will attempt to create a new
shape by rotating it so it stays proportional to the other eye.

CtrlI+C/Command+C the other eye, paste, and line the new up to
your original eye.

Go to Free Transform and HOLD SHIFT. This will allow a
constant/unchanged X and Y axis. Drag it so it goes across the
other eye.

And, that’s it! Yours should look

. . like the one to the left.
(hopefully with a better
mouth).

The pen tool takes patience to
master, but once you do, itis
one of the best tools to use in
Photoshop!
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Lesson #4-3 Activity A

Icon Set
You will be creating an original Icon set in Photoshop.

There will be 2 Photoshop Canvases:
e lcon Formation
e Icon Layout

Dimensions for each Canvas:
e lcon Canvas (256x256px)
e Layout (Normal 8.5x11in)

You will create the icons on the Icon Formation panel, then lay
them all on the layout workspace.

Requirements:
e AT LEAST 9 icons (with one constant color palette and
style).
e Can be original ideas or from popular apps
e Must be ORIGINAL or CHANGED IN SOME WAY!
e Use the Pen Tool!

Submit BOTH .psd files and a .png of your layout panel.
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Lesson #4-3 | Visual Quiz

Juan wants to redesign this poster for his club after school:

GHESS (AND CHECKERS) GLUB'

woo! EVERY MONDAY AND FRIDAY

AFTER SCHOOL!
SCHOO WEE]

LOTS OF FUN PRIZES AND FUN

|
FRIENDSHIPS! $0000 MUCH

wow! FUNI - BILL

You have been tasked with redesigning this poster. Pay close
attention to the principles of design, images you use on the
design, and text size. The poster is a letter sized poster.

IT MUST maintain the same meaning, and include
information about the club (dates, club name).
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LUDDLE 4 UEST PREY

How do you create a new project?

What are common terms related to creating a project?

How do you import assets into a project? (name 2 ways)

What panel allows Creative Clouds users to access their cloud assets? (see

here)

Name all the tools in the selections:

What menu allows you to manipulate or change selections?

What tool/option allows you to transform images?

Where do you add masks? What is the purpose of masks?

What is one tool that allows you to correct an image?

What is an adjustment layer? How can you change or manipulate one of these
layers?
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Give an example of a vector image. What is the tool commonly used to create
these?

What is a vector image?

What panel allows you to manipulate type?

How do you add type to the image?

What is one general rule of filters?

Where do you find filters?
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BONUS: Non-Destructive Editing

Use the following link to review non-destructive editing. Fill the table based
on this link.

Tool How is it Non-Destructive?
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BONUS: Creating Smart Objects

Use this link to review what Smart Objects are.

What is a smart object?

For all digital files, visit https://goo.gl/gsjG18

What is one benefit with working with Smart Objects?

Fill out the following table based on the Adobe reading:

Embedded Smart Object

Linked Smart Object

Benefits

Uses

Data

Name some of the alterations that will alter the pixel data:

PLUS:

Be able to rename, group, lock and link layers.
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Movie Poster
You will create an original movie poster, starring YOU!

Basics:
e Paper size 8.5x14in
o Default color mode and ppi

Requirements:
« MUST feature you somewhere on the poster in a creative
way

« Must have color

e Must use text on the bottom, like a traditional movie
poster

« Must have an original title

The mission is for a country.

GGPRODUCTIONS GUSTAV ENTERTAINMENT present
N IN ASSO: vt DFLIX %

T
TGGEDU PICTURES prooucrio ZAC DELANE "SAVING AMERICA"
Al IAMMER oo ZAC DELAN JOE CRRAAB
DON DEMEQ, ac: "% TAMMY GO TA, nsc
BILL NYE ano BARK MARK & RICO BICO™
v ZAC DELANE [ats | )
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Adobe Goals

o e Export As Prepare images for export
Exporting images from e Quick Export to web, print, and video.
Photoshop can be done in Export or save digital
many ways. images to various file
formats.

You already know file types and the best file for the situation,
and now, we will briefly introduce how to export files in
Photoshop, and after that, you will have needed to learn

everything for the Adobe Certified Associate exam, most of it at
least.

All exporting takes place under File - Export. There are 3 main
options for export:

e Quick Export as .png

e Export As
e Save for Web (Legacy)
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Export As:

Export As
Scale All File Settings
Format: PNG v
Tiin fimd

Smaller File (8-bit)

Image Size

Metadata

© None
Copyright and Contact Info
Color Space

Convert to sRGB

Embed Color Profile

P
Previewing: cover * 100% Cancel ( Export All... )

This is the easiest way to export an image. You can choose your
file type, and basic settings. For a more complex method of
exporting, exporting for web would be a better option.
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Save for Web (100%)

This is the best option for a more diverse method of exporting.
This allows for more customization and Ctrl over the final file.

Printing can also be done by going to File - Print, or
Ctrl/Command+P.

Be sure to pay attention to what the client needs as the final
product!
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Studying for the Adobe e Study Do good on the exam!
Certified Associate Exam
can be done in many ways.

Well, you did it. You’ve finished what | had to offer you for to
prep for the Adobe Certified Associate exam. Some may wonder,
what does the exam even look like? According to the official
Adobe Certified Associate exam guide, it details these details:

Exam Structure

The following lists the topic areas for the exam:

= Setting project requirements

e Understanding Digital Images

* Understanding Adobe Photoshop

= Creating Digital Images Using Adobe Photoshop
< Publishing Digital Images Using Adobe Photoshop

Number of Questions and Time
= 40 questions

* 50 minutes
© 2017 Adobe Systems Incorporated. All rights reserved.

The 40 questions will range from visual demonstration questions
and basic matching terminology questions. For instance, there
may be a question where you match design principles to there
respective definition, or there may be a question where they ask
you to lock a layer in the Photoshop program by doing it in a
simulation.
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These questions can be hard, as there may be multiple ways to
complete a task, but they want one single way. Just remember
to keep trying and remember your basic workspace to navigate.

Now that you’ve grabbed as much info as you can from this
book, what can you do now? | recommend using the Adobe
Certified Guide, as it has some useful study tools and activities
that we may not have covered in this course. Some other
websites, like GMetrix, which is a paid service, offer official
released tests from years past that allow you to get a sense of
the questions they will ask, and just a tip, some of the questions
the ask on the practice exams are questions on the real exam.

The exam is hard, and you ill need to study, especially the visual
demonstration questions, as those will require you to ooze all the
specifics out of you. Remember to study and prep by practicing
the activities I've and Adobe has provided you with!
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Adobe Lightroom allows e Lightroom CC Students will recognize the
designers and e Lightroom Classic significance of Lightroom
photographers to see and and how it connects back
manipulate color. to Photoshop.

Adobe Lightroom may seem like an odd piece of software to
have by novice designers. Yet, it offers so much more than the
average designer may first realize. Lightroom allows designers
and photographers to manipulate color and apply dynamic filters
to the raw image, unlike Photoshop, where one may scale an
image or manipulate and apply filters to it. Lightroom can also
import photos to your computer from your camera, replacing the
computer function, and imminently allow you to apply filters
once the import is complete.

In the 2018 release, Adobe launched a new version of Adobe
Lightroom, dubbed Adobe Lightroom CC which overhauled the
process and Ul. Adobe left the old Lightroom alone, calling it
Lightroom Classic. The tggEdu Photography Mastery exam
primarily focuses on the basics of Lightroom CC.
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T AN e -

The Lightroom Layout looks like this, your pictures on the left,
and edits on the right. Try opening a photo yourself.

The main toolbar looks like this:

el Edit — Edit the content of your photo

<— | Crop and Rotate

<— | Healing Brush

Brush

+—— | Linear Gradient

\ Radical Gradient

There are 5 main options to manipulate and edit the color and
detail of your photos:

Light
Color
Effects
Color

Geometry
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Hopefully you know what cropping is by now. This option allows
you to crop your image to include or exclude certain details.

Crop & Rotate

The healing brush is kind of like the clone stamp tool, it allows
you to heel some of your image (blemishes) or it can act like the
clone stamp tool, replacing some of your image with another
part of the image.

&

()

Healing Brush

Notice the arrow shows what is being replaced with what. The
finger and the green replace the logo on the shirt.

Next is the brush. This tool allows you to paint a certain area
with different edit effects. For instance, say you have a part of
an image you want more exposure on than the rest of the
image. You can use the brush tool, and paint the area of the
image you want more exposure on. This can apply to any of the
filters presented in the edit tool area.
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Linear Gradients apply a gradient of edited effects. Like the
brush tool, Linear gradients allow users to use the same editing
tools to apply a gradient. For instance, you can apply a gradient
to move from a high to low vibrancy.

4
=
i
e
@
e
9
S
©
aQ
E
i

The line represents the end of the gradient, and notice how the
gradient can be changed from edge to edge.

A radical gradient works in the same manor a linear one does.
Instead. The gradient is a radical, circular gradient.

*] @

—
=
o
e
(48]
o
O
<
15
48]
oc

PAGE #123



STUYYLIG FUR TIE THAEDD LA

Studying for the tggEdu e Study Do good on the exam!
mastery in Photography
and Design Exam can be

done in many ways.

The tggEdu Photography Master Exam can be done in only one
way: Study. As a tggEdu Instructor, I know what will be on the
exam, | even wrote some (ok fine, ALL) the questions on the
exam. This certification is nothing to brag about and really can’t
be put on your resume, but it’s still nice to have to show your
achievement. Some tggEdu students may be required to get this
certification to pass Photography classes.

Our MC/Reasoning exams are prefect examples of what tggEdu
exam questions may be like. The test is designed like this:

- 30 Questions
- 1 Hour to Complete

15 Terminology Questions (Domains 1-6)
15 Visual Determination Questions (Domains 3-6)

Terminology Questions are strictly key terms you should know,
for example, the design principles and there definitions. The
Visual Determination questions test you on how to complete
tasks in programs without doing them. You could have to
describe how to do the task in words or pick from predefined
answer choices.
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ADDJTIDIAL PRUJEBTS
BUI-JUALS (03 BOLIEBT AINALS)

You will use your Photoshop knowledge to merge some animals.

Getting Started
o Use 2 web images (it's OK if it's copyrighted) and DRAG
AND DROP into Photoshop.
« One animal will be the head, other is base (or body)

Requirements:
« 3 final merged images (which equals 6 animals found on
Google, etc.)
e Use proper blending, tools, and technique.

Example:

You will be evaluated on:
e Use of proper tools
« Blending technique
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e Proper color merging
e Following the requirements and directions.

102D BANE BOYEY

You will mimic a video game cover you find on the web as best
as you can!

Getting Started:
e 27.4cm x 18.2 cm.
« 300dpi, since this is meant for print

Requirements:
« Mimic a cover found on the web, same colors/layout
« Original cover design, featuring you or other reference
o Similar logo/typeface
« Copyright free images, or teacher approved copyright
images.
e System Branding and ESRB Rating on the cover

Turning in:
« Generate a Letter canvas, place the original and new on
the same canvas
« Turn in the final image of the letter canvas, and the .psd
file of the original artwork.

Example:

Z8\/inyl Cover
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You will design a cover that would be displayed as a cover for a
record.

Getting Started:
e 4.75 inches by 4.75 inches
e 300dpi (since this is print artwork)

Requirements:
« Copyright images of a band you're creating a cover for.
o Creative design, using color and design principles
e Color
« Front and Back, back having song titles by the band
e Use the fest file type for printing.

Turning In
« Create a Letter Size canvas, and place both front and back
covers on the one letter sheet.
e EXxport as the best file type for print.
« Send both .psd files, and the image of the Letter canvas.

Example:
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Result

Free Transform

Decrease Brush Size
Increase Brush Size
Decrease Brush Hardness
Increase Brush Hardness

Default
Foreground/Background colors

Switch
Foreground/Background colors

New layer via copy

New layer via cut

Add to a selection

For all digital files, visit https://goo.gl/gsjG18

Windows

Control + T

Control + J

Shift +
Control + J

Any
selection
tool + Shift-
drag

macOS

Command + T

Command + J

Shift +
Command + J

Any selection
tool + Shift-
drag
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Delete brush or swatch Alt-click Option-click
brush or brush or
swatch swatch

Toggle auto-select with move Control-click = Command-

tool click
Cancel any modal dialog Escape Escape
window (including the Start

Workspace)

Select the first edit field of the  Enter Return

tool bar

Navigate between fields Tab Tab
Navigate between fields in Tab + Shift = Tab + Shift

opposite direction

Change Cancel to Reset Alt Option

Invoke the search experience

Result Windows macOS
Search across Photoshop Ul, Help & Control Command
Learn content, and Adobe Stock + F + F

assets. For more information,
see Photoshop search.

Use function keys
Note:

For macOS, press and hold the Fn key along with the function key (F1-F12) to override
default macOS functions such as screen brightness, volume, etc. For more information on
the behaviour of function keys on your Mac, refer to these Apple documentations:

macOS Sierra: Use keyboard function keys
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Change the behavior of function keys on your Mac

Result Windows macOS
Start Help F1 Help key
Undo/Redo F1

Cut F2 F2

Copy F3 F3

Paste F4 F4
Show/Hide Brush panel F5 F5
Show/Hide Color panel F6 F6
Show/Hide Layers panel F7 F7
Show/Hide Info panel F8 F8
Show/Hide Actions panel F9 Option + F9
Revert F12 F12

Fill Shift + F5 Shift + F5
Feather Selection Shift + F6 Shift + F6
Inverse Selection Shift + F7 Shift + F7
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Select tools

Holding down a key temporarily activates a tool. Letting
go of the key returns to the previous tool.

Note: In rows with multiple tools, repeatedly press the same
shortcut to toggle through the group.

Result Windows macOS

Cycle through tools Shift-press Shift-press

with the same shortcut = shortcut key (if shortcut key (if

key Use Shift Key Use Shift Key for
for Tool Switch Tool Switch
preference is preference is
selected) selected)

Cycle through hidden Alt-click + tool Option-click +

tools (except Add tool (except Add
Anchor Point, Anchor Point,
Delete Anchor Delete Anchor
Point, and Point, and
Convert Point Convert Point
tools) tools)

Move tool \% \%

Rectangular Marquee M M

tool’

Elliptical Marquee tool

Lasso tool L L
Polygonal Lasso tool

Magnetic Lasso tool

Magic Wand tool w w
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Quick Selection tool

Crop tool C C

Slice tool

Eyedropper tool? I I
Color Sampler tool
Ruler tool

Note tool

Spot Healing Brush tool J J
Healing Brush tool
Patch tool

Red Eye tool

Brush tool B B
Pencil tool
Color Replacement tool

Mixer Brush tool

Clone Stamp tool S S

Pattern Stamp tool

History Brush tool Y Y

Art History Brush tool

Eraser tool’ E E
Background Eraser tool

Magic Eraser tool
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Gradient tool G G

Paint Bucket tool

Dodge tool @) @)
Burn tool

Sponge tool

Pen tool P P

Freeform Pen tool

Horizontal Type tool T T
Vertical Type tool

Horizontal Type mask
tool

Vertical Type mask tool

Path Selection tool A A

Direct Selection tool

Rectangle tool U U
Rounded Rectangle tool

Ellipse tool

Polygon tool

Line tool

Custom Shape tool

Hand tool' H H

Rotate View tool R R

PAGE #135



P‘"‘s) Digital For all digital files, visit https://goo.gl/gsjG18

Zoom tool® z 4
Default D D
Foreground/Background

colors

Switch X X
Foreground/Background

colors

Toggle Standard/Quick Q Q

Mask modes

Content-Aware Move J J
tool

Perspective Crop tool C C
Artboard tool \% \%
Rotate View tool R R
Toggle Preserve / (forward / (forward slash)
Transparency slash)

Decrease Brush { {
Hardness

Increase Brush } }
Hardness

Previous Brush , ,

Next Brush
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First Brush < <
Last Brush > >

TUse same shortcut key for Liquify

View images

This partial list provides shortcuts that don’t appear in menu
commands or tool tips.

Result Windows macOS

Cycle through open Control + Tab Control + Tab
documents

Switch to previous Shift + Control Shift +
document + Tab Command +

~(grave accent)

Close a file in Shift-Control-W Shift-Command-
Photoshop and open W

Bridge

Toggle between Q Q

Standard mode and
Quick Mask mode

Toggle (forward) F F
between Standard

screen mode, Full

screen mode with menu

bar, and Full screen

mode

Toggle (backward) Shift + F Shift + F
between Standard

PAGE #137



=4 Digital

screen mode, Full

screen mode with menu

bar, and Full screen
mode

Toggle (forward)
canvas color

Toggle (backward)
canvas color

Fit image in window

Magnify 100%

Switch to Hand tool
(when not in text-edit
mode)

Simultaneously pan
multiple documents
with Hand tool

Switch to Zoom In tool

Switch to Zoom
Out tool

For all digital files, visit https://goo.gl/gsjG18

Spacebar + F
(or right-click
canvas
background and
select color)

Spacebar +
Shift + F

Double-click
Hand tool

Double-click
Zoom tool or

Ctrl + 1

Spacebar

Shift-drag

Control +
spacebar

Alt + spacebar

Spacebar + F
(or Control-click
canvas
background and
select color)

Spacebar +
Shift + F

Double-click
Hand tool

Double-click
Zoom tool or

Command + 1

Spacebar

Shift-drag

Command +
spacebar

Option +
spacebar
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Move Zoom marquee
while dragging with the
Zoom tool

Apply zoom
percentage, and keep
zoom percentage box
active

Zoom in on specified
area of an image

Temporarily zoom into
an image

Scroll image with Hand
tool

Scroll up or down 1
screen

Scroll up or down 10
units

Move view to upper-left
corner or lower-right
corner

For all digital files, visit https://goo.gl/gsjG18

Spacebar-drag

Shift + Enter in
Navigator panel
zoom

percentage box

Control-drag
over preview in
Navigator panel

Hold down H
and then click in
the image and
hold down the
mouse button

Spacebar-drag,
or drag view
area box in
Navigator panel

Page Up or Page
Down?

Shift + Page Up
or Page Down'

Home or End

Spacebar-drag

Shift + Return in
Navigator panel
zoom
percentage box

Command-drag
over preview in
Navigator panel

Hold down H
and then click in
the image and
hold down the
mouse button

Spacebar-drag,
or drag view
area box in
Navigator panel

Page Up or Page
Down?

Shift + Page Up
or Page Down'

Home or End
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Toggle layer mask \ (backslash) \ (backslash)
on/off as rubylith (layer
mask must be selected)

THold down Ctrl (Windows) or Command (macOS) to scroll left
(Page Up) or right (Page Down)
Use Puppet Warp

This partial list provides shortcuts that don’t appear in menu
commands or tool tips.

Result Windows macOS

Cancel completely Esc Esc

Undo last pin adjustment Ctrl+ zZ Command + Z
Select all pins Ctrl + A Command + A
Deselect all pins Ctrl + D Command + D
Select multiple pins Shift-click Shift-click
Move multiple selected pins Shift-drag Shift-drag
Temporarily hide pins H H

Use Refine Edge

Result Windows macOS
Open the Refine Edge dialog Control + Command +
box Alt + R Option + R
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Cycle (forward) through F
preview modes

Cycle (backward) through Shift + F
preview modes

Toggle between original X

image and selection preview

Toggle between original P

selection and refined version

Toggle radius preview on and J
off

Toggle between Refine Radius
and Erase Refinements tools

Use the Filter Gallery

Result Windows

Apply a new filter on = Alt-click a filter

top of selected

Reapply last-used Control + Alt + F

filter

Open/close all Alt-click a

disclosure triangles disclosure
triangle

Change Cancel Control

button to Default

Shift + E

For all digital files, visit https://goo.gl/gsjG18

Shift + F

Shift + E

macOS

Option-click a filter
Control +
Command + F
Option-click a

disclosure triangle

Command
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Change Cancel
button to Reset

Undo/Redo

Step forward

Step backward

Use the Liquify filter

Result

Forward Warp tool

Reconstruct tool

Twirl Clockwise
tool

Pucker tool

Bloat tool

Push Left tool

Mirror tool

Turbulence tool

Freeze Mask tool

For all digital files, visit https://goo.gl/gsjG18

Alt

Control + Z

Control + Shift +
Z

Control + Alt + Z

Windows

Option

Command + Z

Command + Shift
+ Z

Command +
Option + Z

macOS
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Thaw Mask tool

Reverse direction
for Bloat, Pucker,
Push Left, and
Mirror tools

Continually sample
the distortion

Decrease/increase
brush size by 2, or
density, pressure,
rate, or turbulent

jitter by 1

Decrease/increase
brush size by 2, or
density, pressure,
rate, or turbulent

jitter by 1

Cycle through
controls on right
from top

Cycle through
controls on right
from bottom

For all digital files, visit https://goo.gl/gsjG18

D

Alt + tool

Alt-drag in preview
with Reconstruct
tool, Displace,
Amplitwist, or
Affine mode
selected

Down Arrow/Up
Arrow in Brush
Size, Density,
Pressure, Rate, or
Turbulent Jitter
text box'

Left Arrow/Right
Arrow with Brush
Size, Density,
Pressure, Rate, or
Turbulent Jitter
slider showing?’

Tab

Shift + Tab

D

Option + tool

Option-drag in
preview with
Reconstruct tool,
Displace,
Amplitwist, or
Affine mode
selected

Down Arrow/Up
Arrow in Brush
Size, Density,
Pressure, Rate, or
Turbulent Jitter
text boxT

Left Arrow/Right
Arrow with Brush
Size, Density,
Pressure, Rate, or
Turbulent Jitter
slider showing®

Tab

Shift + Tab
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Change Cancel to Alt Option
Reset

THold down Shift to decrease/increase by 10

Use Vanishing Point

Result

Zoom 2x (temporary)

Windows

X

macOS

X

Zoom in Control + + Command + +
(plus) (plus)

Zoom out Control + - Command + -
(hyphen) (hyphen)

Fit in view Control + O Command + O

Zoom to center at

(zero), Double-
click Hand tool

Double-click

(zero), Double-
click Hand tool

Double-click

100% Zoom tool Zoom tool
Increase brush size 1 1

(Brush, Stamp tools)

Decrease brush size [ [

(Brush, Stamp tools)

Increase brush Shift + ] Shift + ]

hardness (Brush,
Stamp tools)
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Decrease brush
hardness (Brush,
Stamp tools)

Undo last action

Redo last action

Deselect all

Hide selection and
planes

Move selection 1 pixel

Move selection 10
pixels

Copy
Paste

Repeat last duplicate
and move

Create a floating
selection from the
current selection

Fill a selection with
image under the
pointer

Shift + [

Control + Z

Control + Shift
+ Z

Control + D

Control + H

Arrow keys

Shift + arrow
keys

Control + C

Control + V

Control + Shift
+ T

Control + Alt +
T

Control-drag

For all digital files, visit https://goo.gl/gsjG18

Shift + [

Command + Z

Command + Shift
+ Z

Command + D

Command + H

Arrow keys

Shift + arrow
keys

Command + C

Command + V

Command + Shift
+ T

Command-drag
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Create a duplicate of Control + Alt- Command +
the selection as a drag Option-drag
floating selection

Constrain selection to Alt + Shift to Option + Shift to
a 15° rotation rotate rotate

Select a plane under Control-click the = Command-click
another selected plane plane the plane

Create 90 degree Control-drag Command-drag

plane off parent plane

Delete last node while = Backspace Delete
creating plane

Make a full canvas Double-click the Double-click the
plane, square to the Create Plane Create Plane tool
camera tool

Use the Camera Raw dialog box
Note:

Holding down a key temporarily activates a tool. Letting go of the key
returns to the previous tool.

Result Windows macOS
Zoom tool Z Z
Hand tool H H

White Balance tool | |
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Color Sampler tool

Crop tool

Straighten tool

Spot Removal tool

Red Eye Removal tool

Basic panel

Tone Curve panel

Detail panel

HSL/Grayscale panel

Split Toning panel

Lens Corrections panel

Camera Calibration panel

Presets panel

Ctrl + Alt
+ 1

Ctrl + Alt
+ 2

Ctrl + Alt
+ 3

Ctrl + Alt
+ 4

Ctrl + Alt
+ 5

Ctrl + Alt
+ 6

Ctrl + Alt
+ 7

Ctrl + Alt
+ 9

For all digital files, visit https://goo.gl/gsjG18

Command + Option
+ 1

Command + Option
+ 2

Command + Option
+ 3

Command + Option
+ 4

Command + Option
+5

Command + Option
+ 6

Command + Option
+7

Command + Option
+ 9 (macOS
Universal Access
zoom shortcut must
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Open Snapshots panel

Parametric Curve
Targeted Adjustment tool

Hue Targeted
Adjustment tool

Saturation Targeted
Adjustment tool

Luminance Targeted
Adjustment tool

Grayscale Mix Targeted
Adjustment tool

Last-used Targeted
Adjustment tool

Adjustment Brush tool

Graduated Filter tool

Increase/decrease brush
size

Ctrl + Alt
+ 9

Ctrl + Alt
+ Shift +
T

Ctrl + Alt
+ Shift +
H

Ctrl + Alt
+ Shift +
S

Ctrl + Alt
+ Shift +
L

Ctrl + Alt
+ Shift +
G

171

For all digital files, visit https://goo.gl/gsjG18

be disabled in
System Preferences)

Command + Option
+9

Command + Option

+ Shift + T

Command + Option
+ Shift + H

Command + Option
+ Shift + S

Command + Option
+ Shift + L

Command + Option
+ Shift + G

171
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Increase/decrease brush
feather

Increase/decrease
Adjustment Brush tool
flow in increments of 10

Temporarily switch from
Add to Erase mode for
theAdjustment

Brush tool, or from Erase
to Add mode

Increase/decrease
temporary Adjustment
Brush tool size

Increase/decrease
temporary Adjustment
Brush tool feather

Increase/decrease
temporary Adjustment
Brush tool flow in
increments of 10

Switch to New mode
from Add or Erase mode
of theAdjustment

Brush tool or

the Graduated Filter

Toggle Auto Mask for
Adjustment Brush tool

Shift + 7/
Shift + [

= (equal
sign) / -
(hyphen)

Alt

Alt +7/
Alt + [

Alt + Shift
+]/7Alt +
Shift + [

Alt + =
(equal
sign) / Alt
+ -

(hyphen)

N

M

Shift + ] / Shift + [

= (equal sign) / -
(hyphen)

Option

Option + ] / Option
+[

Option + Shift + ] /
Option + Shift + [

Option = (equal
sign) / Option + -
(hyphen)

For all digital files, visit https://goo.gl/gsjG18
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Toggle Show Mask for
Adjustment Brush tool

Toggle pins for
Adjustment Brush tool

Toggle overlay for
Graduated Filter, Spot

Removal tool, or Red Eye

Removal tool.

Rotate image left

Rotate image right

Zoom in

Zoom out

Temporarily switch to
Zoom In tool

(Doesn’t work when
Straighten tool is
selected. If Crop tool is
active, temporarily
switches to Straighten
tool.)

Temporarily switch to
Zoom Out tool and
change the Open
Image button to Open

L or Ctrl +
1

R or Ctrl +
[

Ctrl + +
(plus)

Ctrl + -
(hyphen)

Ctrl

Alt

For all digital files, visit https://goo.gl/gsjG18

L or Command + ]

R or Command + [

Command + + (plus)

Command + -

(hyphen)

Command

Option
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Copy and the Cancel
button to Reset.

Toggle preview

Full screen mode

Temporarily activate the
White Balance tool and
change the Open

Image button to Open
Object.

(Does not work if Crop
tool is active)

Select multiple points in
Curves panel

Add point to curve in
Curves panel

Move selected point in
Curves panel (1 unit)

Move selected point in
Curves panel (10 units)

Open selected images in
Camera Raw dialog box
from Bridge

Shift

Click the
first point;
Shift-click
additional
points

Control-

click in
preview

Arrow
keys

Shift-
arrow

Ctrl + R

For all digital files, visit https://goo.gl/gsjG18

Shift

Click the first point;
Shift-click additional
points

Command-click in
preview

Arrow keys

Shift-arrow

Command + R
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Open selected images
from Bridge bypassing
Camera Raw dialog box

Display highlights that
will be clipped in Preview

Highlight clipping
warning

Shadows clipping
warning

(Filmstrip mode) Add 1 -
5 star rating

(Filmstrip mode)
Increase/decrease rating

(Filmstrip mode) Add red
label

(Filmstrip mode) Add
yellow label

(Filmstrip mode) Add
green label

Shift +
double-
click
image

Alt-drag
Exposure,
Recovery,
or Black
sliders

@)

Ctrl +1 -5

Ctrl +.
(period) /
Ctrl+,
(comma)

Ctrl + 6

Ctrl + 7

Ctrl + 8

For all digital files, visit https://goo.gl/gsjG18

Shift + double-click
image

Option-drag
Exposure, Recovery,
or Black sliders

Command + 1 -5

Command + .
(period) /
Command+,
(comma)

Command + 6

Command + 7

Command + 8
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(Filmstrip mode) Add
blue label

(Filmstrip mode) Add
purple label

Camera Raw preferences

Deletes Adobe Camera
Raw preferences

For all digital files, visit https://goo.gl/gsjG18

Ctrl + 9

Ctrl +
Shift + 0 0

Use the Black-and-White dialog box

Result

Open the Black-and-
White dialog box

Increase/decrease
selected value by 1%

Increase/decrease
selected value by 10%

Change the values of
the closest color slider

Use Curves

Result

Command + 9

Command + Shift +

Ctrl + K Command + K
Ctrl + Alt Option + Shift (on
(on open)  open)

Windows macOS

Shift + Control
+ Alt + B

Up Arrow/Down
Arrow

Shift + Up
Arrow/Down
Arrow

Click-drag on
the image

Windows

Shift +
Command +
Option+ B

Up Arrow/Down
Arrow

Shift + Up
Arrow/Down
Arrow

Click-drag on
the image

macOS
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Open the Curves dialog
box

Select next point on the
curve

Select the previous
point on the curve

Select multiple points
on the curve

Deselect a point

To delete a point on the
curve

Move the selected point
1 unit

Move the selected point
10 units

Display highlights and
shadows that will be
clipped

Set a point to the
composite curve

Set a point to the
channel curves

For all digital files, visit https://goo.gl/gsjG18

Control + M

+ (plus)

— (minus)

Shift-click the
points

Control + D

Select a point
and press
Delete

Arrow keys

Shift + Arrow
keys

Alt-drag
black/white
point sliders

Control-click
the image

Shift + Control-

click the image

Command + M

+ (plus)

— (minus)

Shift-click the
points

Command + D

Select a point
and press Delete

Arrow keys

Shift + Arrow
keys

Option-drag
black/white point
sliders

Command-click
the image

Shift +
Command-click
the image
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Toggle grid size

For all digital files, visit https://goo.gl/gsjG18

Alt-click the
field

Select and move objects

Option-click the
field

This partial list provides shortcuts that don’t appear in menu

commands or tool tips.

Result

Reposition marquee
while selecting*

Add to a selection

Subtract from a
selection

Intersect a selection

Constrain marquee
to square or circle
(if no other
selections are
active)*

Draw marquee from
center (if no other
selections are
active)*

Windows

Any marquee tool
(except single
column and single
row) + spacebar-
drag

Any selection tool
+ Shift-drag

Any selection tool
+ Alt-drag

Any selection tool
(except Quick
Selection tool) +
Shift-Alt-drag

Shift-drag

Alt-drag

macOS

Any marquee tool
(except single
column and single
row) + spacebar-
drag

Any selection tool
+ Shift-drag

Any selection tool
+ Option-drag

Any selection tool
(except Quick
Selection tool) +
Shift-Option-drag

Shift-drag

Option-drag
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Constrain shape and
draw marquee from
center?

Switch to Move tool

Switch from
Magnetic Lasso tool
to Lasso tool

Switch from
Magnetic Lasso tool
to polygonal Lasso
tool

Apply/cancel an
operation of the
Magnetic Lasso

Move copy of
selection

Move selection area
1 pixel

Move selection 1
pixel

For all digital files, visit https://goo.gl/gsjG18

Shift + Alt-drag

Control (except
when Hand, Slice,
Path, Shape, or
any Pen tool is
selected)

Alt-drag

Alt-click

Enter/Esc or
Control + .
(period)

Move tool + Alt-
drag selection*

Any selection +
Right Arrow, Left
Arrow, Up Arrow,
or Down Arrow?

Move tool + Right
Arrow, Left
Arrow, Up Arrow,
or Down Arrow™

Shift + Option-
drag

Command (except
when Hand, Slice,
Path, Shape, or
any Pen tool is
selected)

Option-drag

Option-click

Return/Esc or
Command + .
(period)

Move tool +
Option-drag
selectiont

Any selection +
Right Arrow, Left
Arrow, Up Arrow,
or Down Arrow?

Move tool + Right

Arrow, Left Arrow,

Up Arrow, or Down
Arrow™
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Move layer 1 pixel
when nothing
selected on layer

Increase/decrease
detection width

Accept cropping or
exit cropping

Toggle crop shield
off and on

Make protractor

Snap guide to ruler
ticks (except when
View > Snap is
unchecked)

Convert between
horizontal and
vertical guide

For all digital files, visit https://goo.gl/gsjG18

Control + Right
Arrow, Left
Arrow, Up Arrow,
or Down Arrow’

Magnetic Lasso
tool + [ or ]

Crop tool + Enter
or Esc

/ (forward slash)

Ruler tool + Alt-
drag end point

Shift-drag guide

Alt-drag guide

"Hold down Shift to move 10 pixels

*Applies to shape tools

Command + Right
Arrow, Left Arrow,
Up Arrow, or Down
Arrow’

Magnetic Lasso
tool + [ or ]

Crop tool + Return
or Esc

/ (forward slash)

Ruler tool +
Option-drag end
point

Shift-drag guide

Option-drag guide

Transform selections, selection borders, and paths

This partial list provides shortcuts that don’t appear in menu

commands or tool tips.

Result

Windows

macOS
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For all digital files, visit https://goo.gl/gsjG18

Transform from Alt Option

center or reflect

Constrain Shift Shift

Distort Control Command
Apply Enter Return
Cancel Control + . Command + .

(period) or Esc (period) or Esc

Command +
Option + T

Free transform with Control + Alt +
duplicate data T

Command + Shift
+ Option + T

Control + Shift
+ Alt+ T

Transform again with
duplicate data

Edit paths

This partial list provides shortcuts that don’t appear in menu
commands or tool tips.
Result

Windows macOS

Direct selection
tool + Shift-click

Direct selection
tool + Shift-
click

Select multiple anchor
points

Direct selection
tool + Option-
click

Direct selection
tool + Alt-click

Select entire path

Duplicate a path Pen (any Pen
tool), Path
Selection or

Direct Selection

Pen (any Pen
tool), Path
Selection or
Direct Selection
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tool + Control + | tool + Command

Alt-drag + Option-drag
Switch from Path Control Command
Selection, Pen, Add
Anchor Point, Delete
Anchor Point, or
Convert Point tools to
Direct Selection tool
Switch from Pen tool or = Alt Option
Freeform Pen tool to
Convert Point tool
when pointer is over
anchor or direction
point
Close path Magnetic Pen Magnetic Pen
tool-double-click @ tool-double-click
Close path with Magnetic Pen Magnetic Pen tool
straight-line segment tool + Alt- + Option-double-

double-click click

Use for painting

This partial list provides shortcuts that don’t appear in menu
commands or tool tips.

Result Windows macOS

Select Any painting tool + Any painting tool +
foreground = Shift + Alt + right- Control + Option +
color from click and drag Command and drag

color picker
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Select
foreground
color from
image with
Eyedropper
tool

Select
background
color

Color
sampler
tool

Deletes
color
sampler

Sets
opacity,
tolerance,
strength,
or
exposure
for painting
mode

Sets flow
for painting
mode

Any painting tool + Alt
or any shape tool + Alt
(except when Paths
option is selected)

Eyedropper tool + Alt-
click

Eyedropper tool +
Shift

Color sampler tool +
Alt-click

Any painting or editing
tool + number keys
(e.g., 0 = 100%, 1 =
10%, 4 then 5 in quick
succession = 45%)
(when airbrush option
is enabled, use Shift +
number keys)

Any painting or editing
tool + Shift + number
keys (e.g., 0 = 100%o,
1 =10%, 4 then 5 in
quick succession =
45%) (when airbrush
option is enabled, omit
Shift)

For all digital files, visit https://goo.gl/gsjG18

Any painting tool +
Option or any shape
tool + Option (except
when Paths option is
selected)

Eyedropper tool +
Option-click

Eyedropper tool +
Shift

Color sampler tool +
Option-click

Any painting or editing
tool + number keys
(e.g., 0 = 100%, 1 =
10%, 4 then 5 in quick
succession = 45%)
(when airbrush option
is enabled, use Shift +
number keys)

Any painting or editing
tool + Shift + number
keys (e.g., 0 = 100%o,
1 =10%, 4 then 5 in
quick succession =
45%) (when airbrush
option is enabled, omit
Shift)
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Mixer
Brush
changes
Mix setting

Mixer
Brush
changes
Wet setting

Mixer
Brush
changes
Wet and
Mix to zero

Cycle
through
blending
modes

Open Fill
dialog box
on
background
or standard
layer

Fill with
foreground
or
background
color

Fill from
history

Alt + Shift + number

Number keys

00

Shift + + (plus) or —
(minus)

Backspace

Alt + Backspace or

Control + Backspace’

Control + Alt +
Backspace’

For all digital files, visit https://goo.gl/gsjG18

Option + Shift +
number

Number keys

00

Shift + + (plus) or —
(minus)

Delete or Shift + Delete

Option + Delete or
Command + Deletet

Command + Option +

Delete®
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Displays Shift + Backspace Shift + Delete
Fill dialog
box

Lock / (forward slash) / (forward slash)
transparent

pixels

on/off

Connects Any painting tool + Any painting tool +
points with | Shift-click Shift-click

a straight

line

THold down Shift to preserve transparency

Use for blending modes

Result Windows macOS

Cycle through blending Shift + + Shift + +

modes (plus) or — (plus) or —
(minus) (minus)

Normal Shift + Alt + Shift + Option
N + N

Dissolve Shift + Alt + Shift + Option
| + |

Behind (Brush tool only) Shift + Alt + Shift + Option
Q +Q

PAGE #162
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Clear (Brush tool only)

Darken

Multiply

Color Burn

Linear Burn

Lighten

Screen

Color Dodge

Linear Dodge

Overlay

Soft Light

Hard Light

For all digital files, visit https://goo.gl/gsjG18

Shift + Alt +
R

Shift + Alt +
K

Shift + Alt +
M

Shift + Alt +
B

Shift + Alt +
A

Shift + Alt +
G

Shift + Alt +
S

Shift + Alt +
D

Shift + Alt +
W

Shift + Alt +
@)

Shift + Alt +
F

Shift + Alt +
H

Shift + Option
+ R

Shift + Option
+ K

Shift + Option
+ M

Shift + Option
+ B

Shift + Option
+ A

Shift + Option
+ G

Shift + Option
+S

Shift + Option
+ D

Shift + Option
+ W

Shift + Option
+ O

Shift + Option
+F

Shift + Option
+ H
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Vivid Light

Linear Light

Pin Light

Hard Mix

Difference

Exclusion

Hue

Saturation

Color

Luminosity

Desaturate

For all digital files, visit https://goo.gl/gsjG18

Shift + Alt +
\%

Shift + Alt +
J

Shift + Alt +
4

Shift + Alt +
L

Shift + Alt +
E

Shift + Alt +
X

Shift + Alt +
U

Shift + Alt +
T

Shift + Alt +
C

Shift + Alt +
Y

Sponge tool
+ Shift + Alt
+ D

Shift + Option
+V

Shift + Option
+J

Shift + Option
+ Z

Shift + Option
+ L

Shift + Option
+ E

Shift + Option
+ X

Shift + Option
+ U

Shift + Option
+ T

Shift + Option
+C

Shift + Option
+Y

Sponge tool +
Shift + Option
+ D
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Saturate

Dodge/burn shadows
Dodge/burn midtones
Dodge/burn highlights

Set blending mode to
Threshold for bitmap

For all digital files, visit https://goo.gl/gsjG18

Sponge tool Sponge tool +
+ Shift + Alt Shift + Option
+ S + S

Dodge Dodge
tool/Burn tool | tool/Burn tool
+ Shift + Alt + Shift +

+ S Option + S
Dodge Dodge
tool/Burn tool | tool/Burn tool
+ Shift + Alt + Shift +

+ M Option + M
Dodge Dodge
tool/Burn tool | tool/Burn tool
+ Shift + Alt + Shift +

+H Option + H
Shift + Alt + Shift + Option
N + N

images, Normal for all other

images

Select and edit text

This partial list provides shortcuts that don’t appear in menu

commands or tool tips.

Result

Move type in image

Select 1 character
left/right or 1 line

Windows

Control-drag type
when Type layer
is selected

Shift + Left
Arrow/Right
Arrow or Down

macOS

Command-drag
type when Type
layer is selected

Shift + Left
Arrow/Right Arrow
or Down Arrow/Up
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down/up, or 1 word
left/right

Select characters
from insertion point
to mouse click point

Move 1 character
left/right, 1 line
down/up, or 1 word
left/right

Create a new text
layer, when a text
layer is selected in
the Layers panel

Select a word, line,
paragraph, or story

Show/Hide selection
on selected type

Display the

bounding box for
transforming text
when editing text, or
activate Move tool if
cursor is inside the
bounding box

For all digital files, visit https://goo.gl/gsjG18

Arrow/Up Arrow,
or Control + Shift
+ Left
Arrow/Right
Arrow

Shift-click

Left Arrow/Right
Arrow, Down
Arrow/Up Arrow,
or Control + Left
Arrow/Right
Arrow

Shift-click

Double-click,
triple-click,
quadruple-click,
or quintuple-click

Control + H

Control

Arrow, or
Command + Shift
+ Left
Arrow/Right Arrow

Shift-click

Left Arrow/Right
Arrow, Down
Arrow/Up Arrow,
or Command +
Left Arrow/Right
Arrow

Shift-click

Double-click,
triple-click,
quadruple-click,
or quintuple-click

Command + H

Command
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Scale text within a
bounding box when
resizing the
bounding box

Move text box while
creating text box

Format type
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Control-drag a
bounding box
handle

Spacebar-drag

Command-drag a
bounding box
handle

Spacebar-drag

This partial list provides shortcuts that don’t appear in menu

commands or tool tips.

Result

Align left, center, or
right

Align top, center, or
bottom

Choose 100%
horizontal scale

Choose 100% vertical
scale

Choose Auto leading

Choose 0 for tracking

Windows

Horizontal Type
tool + Control +
Shift + L, C, or

R

Vertical Type
tool + Control +
Shift + L, C, or
R

Control + Shift
+ X

Control + Shift
+ Alt + X

Control + Shift
+ Alt + A

Control + Shift
+ Q

macOS

Horizontal Type
tool + Command
+ Shift + L, C, or
R

Vertical Type tool
+ Command +
Shift + L, C, or R

Command + Shift
+ X

Command + Shift
+ Option + X

Command + Shift
+ Option + A

Command +
Control + Shift +

Q
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Justify paragraph, left Control + Shift Command + Shift

aligns last line +J +J

Justify paragraph, Control + Shift Command + Shift

justifies all +F + F

Toggle paragraph Control + Shift Command +

hyphenation on/off + Alt + H Control + Shift +
Option + H

Toggle single/every- Control + Shift Command + Shift

line composer on/off +AIt+T + Option + T

Decrease or increase Control + Shift Command + Shift

type size of selected + < or >T + < or>T

text 2 points or pixels

Decrease or increase Alt + Down Option + Down
leading 2 points or Arrow or Up Arrow or Up
pixels Arrow™? Arrow™?
Decrease or increase Shift + Alt + Shift + Option +
baseline shift 2 points Down Arrow or Down Arrow or
or pixels Up Arrow™? Up Arrow™?
Decrease or increase Alt + Left Arrow  Option + Left
kerning/tracking or Right Arrow'  Arrow or Right
20/1000 ems Arrowt

THold down Alt (Win) or Option (macOS) to decrease/increase
by 10

THold down Ctrl (Windows) or Command (macOS) to
decrease/increase by 10

Slice and optimize
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Result

Toggle between Slice tool and
Slice Selection tool

Draw square slice
Draw from center outward

Draw square slice from
center outward

Reposition slice while
creating slice

Open context-sensitive menu

Use panels

For all digital files, visit https://goo.gl/gsjG18

Windows

Control

Shift-drag

Alt-drag

Shift + Alt-
drag

Spacebar-
drag

Right-click
slice

macOS

Command

Shift-drag

Option-drag

Shift +
Option-drag

Spacebar-drag

Control-click
slice

This partial list provides shortcuts that don’t appear in menu

commands or tool tips.

Result

Set options for new items
(except for Actions, Animation,
Styles, Brushes, Tool Presets,
and Layer Comps panels)

Delete without confirmation
(except for the Brush panel)

Apply value and keep text box
active

Windows

Alt-click
New button

Alt-click
Delete
button

Shift +
Enter

macOS

Option-click
New button

Option-click
Delete
button

Shift +
Return
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Show/Hide all panels

Show/Hide all panels except the
toolbox and options bar

Highlight options bar

Increase/decrease selected

values by 10

Use the Actions panel

Result

Turn command on and
all others off, or turn
all commands on

Turn current modal
control on and toggle
all other modal
controls

Change action or
action set options

Display Options dialog
box for recorded
command

For all digital files, visit https://goo.gl/gsjG18

Tab Tab
Shift + Tab Shift + Tab
Select tool Select tool
and press and press
Enter Return
Shift + Up Shift + Up
Arrow/Down | Arrow/Down
Arrow Arrow
Windows macOS
Alt-click the Option-click the

check mark next
to a command

Alt-click

Alt + double-
click action or
action set

Double-click
recorded
command

check mark next
to a command

Option-click

Option + double-
click action or
action set

Double-click
recorded
command
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Play entire action

Collapse/expand all
components of an
action

Play a command

Create new action and
begin recording
without confirmation

Select contiguous
items of the same kind

Select discontiguous
items of the same kind

Use adjustment layers

Note:
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Control +
double-click an
action

Alt-click the
triangle

Control-click the
Play button

Alt-click the
New Action
button

Shift-click the
action/command

Control-click the
action/command

Command +
double-click an
action

Option-click the
triangle

Command-click
the Play button

Option-click the
New Action
button

Shift-click the
action/command

Command-click
the
action/command

If you prefer channel shortcuts starting with Alt/Option + 1 for red,
choose Edit > Keyboard Shortcuts, and select Use Legacy Channel
Shortcuts. Then restart Photoshop.

Result

Choose specific
channel for
adjustment

Windows

Alt + 3 (red), 4

(green), 5 (blue)

macOS

Option + 3 (red),
4 (green), 5
(blue)
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Choose composite Alt + 2 Option + 2
channel for

adjustment

Delete adjustment Delete or Delete

layer Backspace

Define Auto options Alt-click Auto Option-click Auto
for Levels or Curves button button

Use the Animation panel in Frames mode

Result Windows macOS
Select/deselect Shift-click second @ Shift-click second
multiple contiguous @ frame frame

frames

Select/deselect Control-click Command-click
multiple multiple frames multiple frames
discontiguous

frames

Paste using previous Alt + Paste Option + Paste
settings without Frames command Frames command
displaying the dialog from the Panel from the Panel
box pop-up menu pop-up menu

Use the Brush panel

Result Windows macOS
Delete brush Alt-click brush Option-click
brush
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Rename brush

Change brush size

Decrease/increase brush
softness/hardness

Select previous/next
brush size

Select first/last brush

Display precise cross hair
for brushes

Toggle airbrush option

Use the Channels panel

Note:
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Double-click
brush

Alt + right-click
+ drag left or
right

Alt + right-click
+ drag up or
down

, (comma) or .
(period)

Shift + ,
(comma) or .
(period)

Caps Lock or
Shift + Caps
Lock

Shift + Alt + P

Double-click
brush

Ctrl + Option +
drag left or
right

Ctrl + Option +
drag up or
down

, (comma) or .
(period)

Shift + ,
(comma) or .
(period)

Caps Lock

Shift + Option
+P

If you prefer channel shortcuts starting with Ctrl/Command + 1 for red,

choose Edit > Keyboard Shortcuts, and select Use Legacy Channel
Shortcuts.

Result Windows macOS

Command + 3 (red),
4 (green), 5 (blue)

Select individual
channels

Ctrl + 3 (red), 4
(green), 5 (blue)
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Select composite
channel

Load channel as
selection

Add to current
selection

Subtract from
current selection

Intersect with
current selection

Set options for
Save Selection As
Channel button

Create a new spot
channel

Select/deselect
multiple color-
channel selection

Select/deselect
alpha channel and

Ctrl + 2

Control-click
channel
thumbnail, or Alt
+ Ctrl + 3 (red),
4 (green), 5
(blue)

Control + Shift-
click channel
thumbnail

Control + Alt-click
channel
thumbnail

Control + Shift +
Alt-click channel
thumbnail

Alt-click Save
Selection As
Channel button

Control-click
Create New
Channel button

Shift-click color
channel

Shift-click alpha
channel
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Command + 2

Command-click
channel thumbnail,
or Option +
Command + 3 (red),
4 (green), 5 (blue)

Command + Shift-
click channel
thumbnail

Command + Option-
click channel
thumbnail

Command + Shift +
Option-click channel
thumbnail

Option-click Save
Selection As Channel
button

Command-click
Create New Channel
button

Shift-click color
channel

Shift-click alpha
channel
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show/hide as a
rubylith overlay

Display channel Double-click alpha Double-click alpha or

options or spot channel spot channel
thumbnail thumbnail

Toggle composite  — (tilde) ~ (tilde)

and grayscale
mask in Quick
Mask mode

Use the Clone Source panel

Result Windows macOS

Show Clone Source Alt + Shift Option + Shift
(overlays image)

Nudge Clone Source Alt + Shift + Option + Shift
arrow keys + arrow keys

Rotate Clone Source Alt + Shift + <  Option + Shift
or > + <or>

Scale (increase or reduce Alt + Shift + [ Option + Shift
size) Clone Source or ] + [or]

Use the Color panel

Result Windows macOS
Select background Alt-click color in Option-click color
color color bar in color bar
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Display Color Bar
menu

Cycle through color
choices

Use the History panel

Result

Create a new
snapshot

Rename snapshot

Step forward
through image
states

Step backward
through image
states

Duplicate any
image state,
except the current
state

Permanently clear
history (no Undo)

Right-click color
bar

Shift-click color
bar

Windows

Alt + New
Snapshot

Double-click
snapshot name

Control + Shift +
Z

Control + Alt + Z

Alt-click the image
state

Alt + Clear History
(in History panel
pop-up menu)
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Control-click color
bar

Shift-click color bar

macOS

Option + New
Snapshot

Double-click
snapshot name

Command + Shift
+ Z

Command + Option
+ Z

Option-click the
image state

Option + Clear
History (in History
panel pop-up
menu)
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Use the Info panel

Result

Change color readout

modes

Change measurement

units

Use the Layers panel

Result

Load layer
transparency as a
selection

Add to current
selection

Subtract from
current selection

Intersect with
current selection

Load filter mask as

a selection

Windows

Click eyedropper

icon

Click crosshair
icon

Windows

Control-click layer
thumbnail

Control + Shift-
click layer
thumbnail

Control + Alt-click
layer thumbnail

Control + Shift +
Alt-click layer
thumbnail

Control-click filter
mask thumbnail

macOS

Click eyedropper
icon

Click crosshair
icon

macOS

Command-click
layer thumbnail

Command + Shift-
click layer
thumbnail

Command +
Option-click layer
thumbnail

Command + Shift
+ Option-click layer
thumbnail

Command-click
filter mask
thumbnail

For all digital files, visit https://goo.gl/gsjG18
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New layer

New layer via copy

New layer via cut

Group layers

Ungroup layers

Create/release
clipping mask

Select all layers

Merge visible
layers

Create new empty
layer with dialog
box

Create new layer
below target layer

Select top layer

Select bottom
layer

Control + Shift+
N

Control + J

Shift + Control +
J

Control + G

Control + Shift +
G

Control + Alt + G

Control + Alt + A

Control + Shift +
E

Alt-click New
Layer button

Control-click New
Layer button

Alt + . (period)

Alt + , (comma)
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Command + Shift+
N

Command + J

Shift + Command
+J

Command + G

Command + Shift
+ G

Command + Option
+ G

Command + Option
+ A

Command + Shift
+ E

Option-click New
Layer button

Command-click
New Layer button

Option + . (period)

Option +
(comma)
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Add to layer
selection in Layers
panel

Select next layer
down/up

Move target layer
down/up

Merge a copy of all
visible layers into
target layer

Merge layers

Move layer to
bottom or top

Copy current layer
to layer below

Merge all visible
layers to a new
layer above the
currently selected
layer

Show/hide this
layer/layer group

Shift + Alt + [ or
1

Alt + [ or ]

Control + [ or ]

Control + Shift +
Alt + E

Highlight layers
you want to
merge, then
Control + E

Control + Shift +
[or]

Alt + Merge Down
command from
the Panel pop-up
menu

Alt + Merge
Visible command
from the Panel
pop-up menu

Right-click the
eye icon
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Shift + Option + [
or ]

Option + [ or ]

Command + [ or ]

Command + Shift
+ Option + E

Highlight the layers
you want to merge,
then Command + E

Command + Shift
+ [or]

Option + Merge
Down command
from the Panel
pop-up menu

Option + Merge
Visible command
from the Panel
pop-up menu

Control-click the
eye icon
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only or all
layers/layer groups

Show/hide all other
currently visible
layers

Toggle lock
transparency for
target layer, or last
applied lock

Edit layer
effect/style,
options

Hide layer
effect/style

Edit layer style

Disable/enable
vector mask

Open Layer Mask
Display Options
dialog box

Toggle layer mask
on/off

Toggle filter mask
on/off

Alt-click the eye
icon

/ (forward slash)

Double-click layer
effect/style

Alt-double-click
layer effect/style

Double-click layer

Shift-click vector
mask thumbnail

Double-click layer
mask thumbnail

Shift-click layer
mask thumbnail

Shift-click filter
mask thumbnail
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Option-click the
eye icon

/ (forward slash)

Double-click layer
effect/style

Option-double-click
layer effect/style

Double-click layer

Shift-click vector
mask thumbnail

Double-click layer
mask thumbnail

Shift-click layer
mask thumbnail

Shift-click filter
mask thumbnail
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Toggle between
layer
mask/composite
image

Toggle between
filter
mask/composite
image

Toggle rubylith
mode for layer
mask on/off

Select all type;
temporarily select
Type tool

Create a clipping
mask

Rename layer
Edit filter settings

Edit the Filter
Blending options

Create new layer
group below
current layer/layer
set

Alt-click layer
mask thumbnail

Alt-click filter
mask thumbnail

\ (backslash), or
Shift + Alt-click

Double-click type
layer thumbnail

Alt-click the line
dividing two
layers

Double-click the
layer name

Double-click the
filter effect

Double-click the
Filter Blending
icon

Control-click New
Group button
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Option-click layer
mask thumbnail

Option-click filter
mask thumbnail

\ (backslash), or
Shift + Option-click

Double-click type
layer thumbnail

Option-click the
line dividing two
layers

Double-click the
layer name

Double-click the
filter effect

Double-click the
Filter Blending icon

Command-click
New Group button
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Create new layer
group with dialog
box

Create layer mask
that hides
all/selection

Create vector
mask that reveals
all/path area

Create vector
mask that hides all
or displays path
area

Display layer group
properties

Select/deselect
multiple
contiguous layers

Select/deselect
multiple
discontiguous
layers

Note:

Alt-click New
Group button

Alt-click Add
Layer Mask button

Control-click Add
Layer Mask button

Control + Alt-click
Add Layer Mask
button

Right-click layer
group and choose
Group Properties,
or double-click

group

Shift-click

Control-click

For all digital files, visit https://goo.gl/gsjG18

Option-click New
Group button

Option-click Add
Layer Mask button

Command-click
Add Layer Mask
button

Command +
Option-click Add
Layer Mask button

Control-click the
layer group and
choose Group
Properties, or
double-click group

Shift-click

Command-click

If Kotoeri is your Japanese language input method, the “Toggle rubylith
mode for layer mask on/off” shortcut starts an action in Kotoeri. Please
switch to another mode (for example, “U.S.”) to enable this shortcut.
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Use the Layer Comps panel

Result Windows macOS

Create new layer comp @ Alt-click Create Option-click

without the New Layer New Layer Create New Layer
Comp box Comp button Comp button
Open Layer Comp Double-click Double-click layer
Options dialog box layer comp comp
Rename in-line Double-click Double-click layer
layer comp comp name
name
Select/deselect Shift-click Shift-click
multiple contiguous
layer comps
Select/deselect Control-click Command-click

multiple discontiguous
layer comps

Use the Paths panel

Result Windows macOS
Load path as selection Control- Command-
click click

pathname pathname

Add path to selection Control + Command
Shift-click =+ Shift-
pathname @ click

pathname
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Subtract path from selection

Retain intersection of path as
selection

Hide path

Set options for Fill Path

with Foreground Color button, Stroke
Path with Brush button, Load Path
as a Selection button, Make Work
Path from Selection button and
Create New Path button

Use the Swatches panel

Result Windows

Create new swatch
from foreground color

Set swatch color as

background color swatch

Delete swatch

Click in empty
area of panel

Control-click

Alt-click swatch
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Control +
Alt-click
pathname

Control +
Shift +
Alt-click
pathname

Control +
Shift + H

Alt-click
button

macOS

Command
+ Option-
click

pathname

Command
+ Shift +
Option-
click
pathname

Command
+ Shift +
H

Option-
click
button

Click in empty

area of panel

Command-click

swatch

Option-click
swatch
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Use Extract and Pattern Maker (optional plug-ins)

Result (Extract and Windows macOS
Pattern Maker)
Fit in window Control + O Command + O

Zoom in Control + + Command + +
(plus) (plus)

Zoom out Control + - Command + -
(hyphen) (hyphen)

Cycle through Tab Tab

controls on right

from top

Cycle through Shift + Tab Shift + Tab

controls on right

from bottom

Temporarily activate = Spacebar Spacebar

Hand tool

Change Cancel to Alt Option

Reset

Result (Extract only) Windows macOS

Edge Highlighter tool B B

Fill tool G G

Eyedropper tool
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Result (Extract and
Pattern Maker)

Cleanup tool
Edge Touchup tool

Toggle between
Edge Highlighter tool
and Eraser tool

Toggle Smart
Highlighting

Remove current
highlight

Highlight entire
image

Fill foreground area
and preview
extraction

Move mask when
Edge Touchup tool is
selected

Add opacity when
Cleanup tool is
selected

Toggle Show menu
options in preview

For all digital files, visit https://goo.gl/gsjG18

Windows

Alt + Edge
Highlighter/Eraser
tool

Control with Edge
Highlighter tool
selected

Alt + Delete

Control + Delete

Shift-click with Fill
tool selected

Control-drag

Alt-drag

macOS

Option + Edge
Highlighter/Eraser
tool

Command with
Edge Highlighter
tool selected

Option + Delete
Command +
Delete

Shift-click with Fill

tool selected

Command-drag

Option-drag
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Result (Extract and
Pattern Maker)

between Original
and Extracted

Enable Cleanup and
Edge Touchup tools
before preview

Cycle through
Display menu in
preview from top to
bottom

Cycle through
Display menu in
preview from bottom
to top

Decrease/increase
brush size by 1

Decrease/increase
brush size by 1

Set strength of
Cleanup or Edge
Touch-up tool

THold down Shift to decrease/increase by 10

For all digital files, visit https://goo.gl/gsjG18

Windows

Shift + X

Shift + F

Down Arrow/Up
Arrow in Brush
Size text box™

Left Arrow/Right
Arrow with Brush
Size Slider
showing?’

0-9

macOS

Shift + X

Shift + F

Down Arrow or Up
Arrow in Brush
Size text box™

Left Arrow/Right
Arrow with Brush
Size Slider
showing?’

0-9
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Result (Extract and Windows macOS

Pattern Maker)

Result (Pattern Maker = Windows macOS

only)

Delete current Control + D Command + D
selection

Undo a selection Control + Z Command + Z
move

Generate or Control + G Command + G

generate again

Intersect with Shift + Alt + Shift + Option +
current selection select select

Toggle view: X X
original/generated

pattern

Go to first tile in Tile Home Home

History

Go to last tile in Tile End End

History

Go to previous tile in | Left Arrow, Page Left Arrow, Page
Tile History Up Up

Go to next tile in Tile = Right Arrow, Page Right Arrow, Page
History Down Down
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Result (Extract and Windows macOS
Pattern Maker)
Delete current tile Delete Delete

from Tile History

Nudge selection
when viewing the
original

Right Arrow, Left
Arrow, Up Arrow,
or Down Arrow

Right Arrow, Left
Arrow, Up Arrow,
or Down Arrow

Increase selection
nudging when
viewing the original

Shift + Right
Arrow, Left Arrow,
Up Arrow, or
Down Arrow

Shift + Right
Arrow, Left Arrow,
Up Arrow, or
Down Arrow
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WHIRUESHER]

Your original Project Title:

What programs did you use? What filters or tools did you use?

What images did you use? (links) What other items did you use?

What was your motive behind the project? Why did you choose the composition of the
image?

How did you incorporate the provided How did you incorporate the provided images

requirements into your project? into your project?

Write a 2-3 sentence artist statement, explaining your motives and graphic principles incorporated
into your design:

PAGE #190



Digital For all digital files, visit https://goo.gl/gsjG18

WESSITES TU w2l T0U PREPARE

GMetrix is a paid service that gives mock Adobe Certified
associate exams. It involves simulations that help you prep for
the exam, and a lot of questions they ask will be on the exam.

YouTube has A LOT of tutorials, from creating animations, and
fun and unique projects. If your confused on a subject, look it up
on YouTube, and you’re sure to find a tutorial.

https://photoshoptrainingchannel.com/ is another great website to
help cover and train in new skills in Photoshop. Some tutorials
are paid, but they have a lot of free resources.
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TBRZDY BUALS

Students who are taking The Digital Way course have the opportunity
to be certified by tggEdu in Adobe Photoshop for Graphic and Photo
Manipulation. This exam demonstrates more program based skills and
accelerates more skills than the Adobe Certified exam. Below is the
tggEdu basic structure of goals review on the exam:

For all digital files, visit https://goo.gl/gsjG18

AREA A: Demonstration of Project Management

TGG1.011 Demonstration of basic project requirements, including mock ups, drafting, and basic
time management.

TGG1.012 Demonstration of US Copyright law's, fair use, and public domains

TGG1.013 Demonstrate knowledge of the client and employer relationship.

AREA B: Demonstration of Digital Image terminology

TGG2.014 Demonstrate knowledge of digital image terminology, such as a vector or raw image.
TGG2.015 Demonstrate knowledge of the principles of design, such as Harmony and Repetition.
TGG2.016 Demonstrate knowledge of image size and resolution, and know common types of

resolutions and print layouts (1920x1080, 8.5inx11in)

AREA C: Demonstration of Photoshop/Lightroom Knowledge

TGG3.017 Demonstrate knowledge of creating or importing a new image.

TGG3.018 Demonstrate knowledge of Photoshop tools, groups and the functions they perform.

TGG3.019 Demonstrate knowledge of the workspace, and the common panels and what
functions they perform.

TGG3.020 Demonstrate knowledge of common panels, such as the layers and brushes panel.

TGG3.021 Demonstrate knowledge of using selection tools, and be able to differ between them.

TGG3.022 Demonstrate knowledge of blending, including auto blending and content aware
filling.

TGG3.023 Demonstrate knowledge of creating new workspaces, documents, and graphics.

TGG3.024 Demonstrate knowledge in Adobe Lightroom CC
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AUD3E BUALS

Domain 1.0 Setting Project Requirements

1.1 Identify the purpose, audience, and audience needs for
preparing images.

1.2 Summarize how designers make decisions about the type of
content to include in a project,

including considerations such as copyright, project fit,
permissions, and licensing.

1.1 Demonstrate knowledge of project management tasks and
responsibilities.

1.3 Communicate with others (such as peers and clients) about
design plans.

Domain 2.0 Understanding Digital Images
2.1 Understand key terminology related to digital images.

2.2 Demonstrate knowledge of basic design principles and best
practices employed in the visual

design industry.

2.3 Demonstrate knowledge of typography and its use in visual
design.

2.4 Demonstrate knowledge of color and its use in digital
images.

2.5 Demonstrate knowledge of image resolution, image size, and
image file format for web, video,

and print.

Domain 3.0 Understanding Adobe Photoshop

3.1 ldentify elements of the Photoshop CC user interface and
demonstrate knowledge of their functions.
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3.2 ldentify and define the functions of commonly used Panels,
including the Properties, Layers, Brushes, Adjustments, and
Type panels.

3.3 Define the functions of commonly used tools, including
selection, drawing, painting, type, and vector shape tools.

3.4 Navigate, organize, and customize the workspace.

3.5 Use non-printing design tools in the interface, such as rulers
and guides.

3.6 Demonstrate knowledge of layers and masks.
3.7 Manage colors, swatches, and gradients.

3.8 Manage brushes, symbols, graphic styles, and patterns.

Domain 4.0 Creating Digital Images Using Adobe Photoshop
4.1 Create a new project.

4.2 Import assets into a project.

4.3 Make, manage, and manipulate selections.

4.4 Transform images.

4.5 Create and manage layers and masks.

4.6 Use basic retouching techniques — including color correction,
blending, cloning, and filters —

to manipulate a digital image.

4.7 Create a vector drawing, such as an icon, button, or layout.
4.8 Add and manipulate type.

4.9 Add filters.

Domain 5.0 Publishing Digital Images Using Adobe Photoshop

5.1 Prepare images for export to web, print, and video.

5.2 Export or save digital images to various file formats.
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.bmp, 52, 57

.gif, 52, 57

.jpeg, 52,57

.png, 52, 57,79, 81, 96, 103, 111
.tiff, 52, 57

____+ 1

4K, 51, 54

I

720p, 51, 54

s 1

8.5x11in, 90, 103

A~

Adjustments, 60, 62, 66

Adobe Bridge, 13, 14

Alignment, 40, 43

Alt, 79, 125, 126, 128, 133, 135, 136, 137, 138,
139, 140, 141, 142, 143, 144, 145, 146, 147,
148, 149, 150, 151, 152, 153, 154, 155, 156,
157, 159, 160, 161, 162, 163, 164, 165, 166,
167, 168, 169, 170, 171, 172, 173, 174, 175,
176,178

Analogous, 46, 49, 50, 57

Auto Blending, 83

s 1

Bitmap, 34, 35, 54

Blending Options, 73, 78

Brush, 69, 78, 81, 125, 127, 129, 131, 137, 138,
139, 142,143,153, 155, 161, 164, 174, 177

budget, 19

Building and Testing, 20

. c

Canvas, 69, 103
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clients, 18, 20, 24, 25

Collaboration, 26, 31

color, 34, 35, 36, 38, 43, 45, 46, 48, 49, 52, 54,
55, 56, 57, 58, 59, 61, 62, 73, 81, 89, 95, 96,
97,103, 110, 121, 123, 132, 147, 152, 153,
154, 166, 167, 168, 174, 175

Color Management, 84

Communication, 4, 24, 25, 29

Complementary, 46, 49, 50, 57

Contrast, 38, 39, 43

Copyright, 4, 12, 13, 16, 28, 31, 73, 122, 123

Creative Commons, 13, 16, 17

Crop Tool, 70

Ctrl+R, 61

o 1

Demographics, 9, 11, 28

Design, 4, 20, 21

design principles, 37, 40, 41, 44, 58, 123

Display, 45, 47, 56, 145, 147, 158, 162, 164, 166,
167,171,172,177

¢ ]

Edit, 68, 69, 70, 73, 82, 151, 163, 165, 170, 171,
172

Email Header, 51, 54

eye, 61, 68, 73, 102, 103, 170

]

Fair Use, 4, 13, 16, 28

Fill, 11, 16, 22, 35, 48, 49, 52, 54, 55, 56, 57, 61,
83,107, 109, 127, 139, 154, 174, 175, 176

font, 38, 39, 45, 46, 47, 56, 73, 74, 82, 90, 97

Free Transform, 68

¢ 1

gradient, 73, 89
gradient tool, 73

___u ]

Harmony, 40, 43, 49, 57
HD, 34, 51, 54
HEX, 49, 61, 62
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Digital

Hierarchy, 45, 48, 56
Hue, 46, 49, 57, 69, 142, 156

x|

Kerning, 45, 48, 56, 63

]

Lasso, 68, 84, 128, 149, 150

layer, 61, 62, 67, 68, 69, 70, 73, 80, 81, 82, 90,
97, 106, 125, 134, 150, 154, 158, 163, 168,
169, 170, 171,172,173

Layer Masks, 83

Leading, 45, 48, 56, 63

Legal Paper, 51, 54

Letter Paper, 51, 54

License, 28, 179

M

Magic, 68, 69, 73, 77, 128, 129
masks, 81

Method Mismatch, 19
Monochromatic, 46, 49, 50, 57

_~ |

Normal Photo, 51, 54

o ]

Object, 34, 109, 144
opacity, 73, 153, 176
Opacity, 82

1

Paint, 79, 81, 97, 129

panel, 61, 62, 63, 66, 67, 68, 73, 81, 82, 85, 86,
89, 102, 103, 106, 107, 127, 133, 134, 141,
144,145, 158, 161, 162, 163, 164, 165, 166,
167, 168, 169, 173, 174

Paste Special, 70

path, 102, 151, 152, 172, 174

Path, 34, 35, 55, 101, 130, 149, 151, 152, 174

pen, 99, 101, 102, 103

Pen, 99, 102, 103, 130, 149, 151, 152

pen tool, 99

photoshop, 27, 74, 79
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Photoshop, 2, 13, 14, 34, 35, 36, 54, 55, 60, 61,
66, 67,73, 78,79, 82, 84, 89, 90, 91, 93, 95,
96, 103, 111, 121, 126, 132, 163, 180

PHOTOSHOP!, 93

Pitch Meeting, 19

Pixels, 34, 35, 36, 51, 54

Planning and analysis, 20

PMI, 18, 19

PNG, 82, 90

preset, 91

Printing, 113

professionalism, 18, 20, 25

Professionalism, 22, 26, 28, 29, 31

project, 9, 11, 12, 13, 15, 18, 19, 20, 23, 24, 25,
29, 30, 35, 55, 59, 91, 105, 106, 180

Project Management Institute, 18

Proofing and Revising, 20

Proximity, 39, 43

purpose, 8, 9, 14, 89, 101, 106

Purpose, 4, 11, 15, 28

__________a |

Quick Selection, 69, 73, 77, 79, 128, 148

I

Raster, 34

Raw images, 52, 57

Rectangle Marquee, 70, 73
Render, 34, 35, 36, 55

Repetition, 37, 42

Resolution, 34, 51

Right-click, 61, 161, 167, 170, 172
Rule of 3rds, 83

Ruler Guides, 83

Rulers, 61

s

Saturation, 46, 49, 57, 69, 142, 157

Save for Web, 111, 113

Scale, 40, 43, 159, 166

Scope, 19, 23, 24, 29

Scope Creep, 19, 24

selections, 34, 46, 106, 148, 149, 150

Serif, 45, 47, 56

shape, 32, 34, 61, 62, 63, 67, 102, 149, 150, 152

size, 38, 40, 50, 51, 52, 73, 81, 97, 105, 110, 137,
138, 142, 143, 148, 160, 164, 166, 177

Swatches, 84, 174
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T Type, 34, 35, 45, 51, 60, 66, 73, 78, 97, 102, 130,
\é 158,159,171

Target Audience, 11, 28
Teamwork, 26, 30 Vv I
Tetradic, 46, 49
tool, 53, 61, 63, 68, 69, 70, 73, 79, 81, 82, 84, 87, Value, 46, 49, 57, 69
97,99, 101, 102, 103, 106, 125, 126, 127, 128, Vector, 34, 52
129, 130, 131, 132, 133, 134, 136, 137, 138,
140, 141, 142, 143, 144, 148, 149, 150, 151,

152, 153, 154, 155, 157, 158, 159, 161, 162, I#I

171,175,176, 177 b, 10, 20, 46, 49, 50, 96, 112, 121, 122
Tracking, 45, 48, 56, 63 WD, 25, 25, 45, 89, 98, 95, 124, 254

Triatic, 46, 49, 50, 57 window, 62, 68, 73, 81, 126, 133, 175
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